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●● About the Product Warranty
Every effort has been made to ensure that the information in this document is complete, accurate, 
and up-to-date. The manufacturer assumes no responsibility for the results of errors beyond its 
control. The manufacturer also cannot guarantee that changes in software and equipment made by 
other manufacturers and referred to in this guide will not affect the applicability of the information 
in it. Mention of software products manufactured by other companies does not necessarily constitute 
endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful as 
possible, we make no warranty of any kind, expressed or implied, as to the accuracy or completeness 
of the information contained herein.

All rights are reserved by Oki Electric Industry Co., Ltd. You must not copy, transfer, translate, etc. 
the content herein without authorization. You must obtain written permission from Oki Electric 
Industry Co., Ltd. before doing any of the above.

© 2016 Oki Electric Industry Co., Ltd.

OKI is a registered trademark of Oki Electric Industry Co., Ltd.

Energy Star is a trademark of the United States Environmental Protection Agency.

Microsoft, Windows, Windows Server and Windows Vista are registered trademarks of Microsoft 
Corporation.

Apple, Mac and OS X are registered trademarks of Apple Inc.

Other product names and brand names are registered trademarks or trademarks of their proprietors.

This product complies with the requirements of the Council Directives 2014/30/EU (EMC),
2014/35/EU (LVD), 2014/53/EU (RED), 2009/125/EC (ErP) and 2011/65/EU(RoHS), 
as amended where applicable, on the approximation of the laws of the member states relating to
Electromagnetic Compatibility, Low Voltage, Radio & Telecommunications Terminal Equipment, 
Energy related Products and Restriction on the use of certain Hazardous Substances in electrical 
and electronic equipment.

The following cables were used to evaluate this product for EMC directive 2014/30/EU compliance, 
and configurations other than this may affect that compliance.

cable type length 
(meters) core shield

Power 1.8

USB 5.0

LAN 15.0
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●● Emergency first aid
Take care with toner powder:

 If swallowed, give small amounts of cold water and seek medical attention. DO 
NOT attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical attention.

If it gets into the eyes, flush with large amounts of water for at least 15 minutes 
keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk of 
staining skin or clothing.

●

● Environmental information

w

ww
.ok
i.com/printing/

●● ENERGY STAR
Target countries of the ENERGY STAR program are the United States, Canada and Japan.  

 
It is not applicable to other countries. 
This product is compliant with ENERGY STAR v2.0 only.  

http://www.oki.com/printing/
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●● For Your Safety
Read the User’s Manual for your safety before using the product.

Cautions related to safety

WARNING A warning provides additional information which, if ignored, may result in a risk of personal 
injury.

CAUTION A caution provides additional information which, if ignored, may result in equipment 
malfunction or damage.

General cautions

WARNING

Do not touch the safety 
switch inside the printer. 
Doing so may cause electric 
shock when high voltage 
occurs. In addition, the 
rotating gears may result in 
injury.

Do not use highly flammable 
sprays near the printer. Doing 
so may cause fire as parts of 
the printer are hot.

Unplug the power cord 
and contact a customer 
service center if the cover 
is unusually hot, smoking, 
giving off an unusual odor, 
or making strange noises. 
Failure to do so may lead to 
a fire.

Unplug the power cord and 
contact a customer service 
center if a liquid such as 
water enters in the internal 
parts of the printer.
Failure to do so may lead to 
a fire.

Unplug the power cord and 
remove foreign materials 
such as paper clips if they 
fall inside the printer. Failure 
to do so may cause electric 
shock and/or fire, leading to 
injuries.

Do not operate and/or 
disassemble the printer other 
than as directed in User’s 
Manual. Doing so may cause 
electric shock and/or fire, 
leading to injuries.

Unplug the power cord 
and contact a customer 
service center if the printer 
is dropped or the cover is 
damaged.
Failure to do so may cause 
electric shock and/or fire, 
leading to injuries.

Unplug the power cord 
periodically to clean plug 
blades and base section 
between the blades.
If the power plug remains 
inserted for a long time, the 
base section will get dusty, 
and the plug may short 
circuit, which may cause fire.

Do not clean spilled toner 
with a vacuum cleaner.
If cleaning spilled toner with 
a vacuum cleaner, it may 
catch fire due to the sparks 
from electric contact.
Toner spilled on the floor 
should be wiped off with wet 
cloth.

Do not insert materials in a 
vent hole.
Doing so may cause electric 
shock and/or fire leading to 
personal injuries.

Do not put a cup with liquids 
such as water on the printer.
Doing so may cause electric 
shock and/or fire leading to 
personal injuries.

Do not touch the fuser and 
other parts when opening the 
cover of the printer.
Doing so may cause burns.

Do not throw toner cartridges 
and image drum cartridges 
into fire. Doing so may cause 
dust explosion leading to 
burns.

Do not use a power cord, a 
cable, or a ground wire other 
than those that are indicated 
in User's Manual.
Doing so may cause fire.

The operation of using UPS 
(uninterruptible power 
source) or inverters is not 
guaranteed. Do not use 
uninterruptible power source 
or inverters.
Doing so may cause fire.

CAUTION

Do not come closer to the paper’s exit area 
when the power is turned on, while printing.
Doing so may result in personal injury.

Do not touch a damaged liquid-crystal display.
If liquid (liquid crystal) leaked from the liquid-
crystal display gets into the eyes or mouth, flush 
with large amount of water. Follow the direction 
from a doctor if necessary.
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●● Manual Composition
The following manuals are included with this product.

●● User’s Manual (Setup) ---- This document
Basic operations are described to aid understanding of this printer. The initial setup descriptions 
including printer placement and the network initial setting are noted along with troubleshooting and 
maintenance procedures.

●● About This Manual

Terms in this document

The following terms are used in this manual.

Note

●● Indicates important information on operations. Make sure to read sections with this mark.

Memo

●● Indicates additional information on operations. You should read sections with this mark.

Reference

●● Indicates where to look when you want to know more detailed or related information.

WARNING

●● A warning provides additional information which, if ignored, may result in a risk of personal injury.

CAUTION
●● A caution provides additional information which, if ignored, may result in equipment malfunction or 
damage.

Symbols in this document

The following symbols are used in this manual.

Symbols Description
[  ] ●● Indicates menu names on the display screen.

●● Indicates menu, window, and dialog names on the computer.
"  " ●● Indicates messages and input text on the display screen.

●● Indicates file names on the computer.
●● Indicates reference titles.

<  > button/key Indicates a hardware button on the operator panel or a key on the keyboard of the 
computer.

> Indicates how to get to the item you want in the menu of this printer or the computer.
Your Printer Indicates a printer you want to use or select.
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Notation used in this manual

The following notations may be used in this manual.

●● C813n→ C813

●● C823n/C823dn→ C823

●● C833n/C833dn→ C833

●● C843n/C843dn→ C843

●● PostScript3 Emulation→ PSE, POSTSCRIPT3 Emulation, POSTSCRIPT3 EMULATION

●● Microsoft® Windows® 10 64-bit Edition operating system→ Windows 10 (64bit version) *

●● Microsoft® Windows® 8.1 64-bit Edition operating system→ Windows 8.1 (64bit version) *

●● Microsoft® Windows® 8 64-bit Edition operating system→ Windows 8 (64bit version) *

●● Microsoft® Windows® 7 64-bit Edition operating system→ Windows 7 (64bit version) *

●● Microsoft® Windows Vista® 64-bit Edition operating system→ Windows Vista (64bit version) *

●● Microsoft® Windows Server® 2012 R2 64-bit Edition operating system→ Windows Server 2012 *

●● Microsoft® Windows Server® 2012 64-bit Edition operating system→ Windows Server 2012 *

●● Microsoft® Windows Server® 2008 R2 64-bit Edition operating system→ Windows Server 2008 *

●● Microsoft® Windows Server® 2008 64-bit Edition operating system→ Windows Server 2008 (64bit version) *

●● Microsoft® Windows® 10 operating system→ Windows 10 *

●● Microsoft® Windows® 8.1 operating system→ Windows 8.1 *

●● Microsoft® Windows® 8 operating system→ Windows 8 *

●● Microsoft® Windows® 7 operating system→ Windows 7 *

●● Microsoft® Windows Vista® operating system→ Windows Vista *

●● Microsoft® Windows Server® 2008 operating system→ Windows Server 2008 *

●● Generic name for Windows 10, Windows 8.1, Windows 8, Windows Server 2012, Windows 7, Windows Vista, and  
Windows Server 2008→ Windows

* �If there is no special description, 64bit version is included in Windows 10, Windows 8.1, Windows 8, Windows 7,
Windows Vista, and Windows Server 2008. (64bit version and Windows Server 2008 R2 is included in Windows
Server 2008, Windows Server 2012 R2 is included in Windows Server 2012.)

If there is no special description, Windows 7 is used as Windows, Mac OS X 10.11 is used as Mac OS X, and 
C833dn is used as the printer for examples in this document.

Depending on your OS, model or version, the description on this document may be different.

The diffusion of dust, ozone, styrene, benzene, TVOC, and ultrafine particles conforms to the Eco Mark 
155, “Printer” substance emission certification criteria. (Toner was tested by performing black and 
white and color printing with OKI genuine toner cartridges according to the appendix S-M of the Blue 
Angel RAL UZ-171:2012 test method.)
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1.	Setup
How to set up is explained in this chapter.

�� Setup Flow
1. Checking Products

●● Checking package contents
●● Checking names of the operator panel and how to 
operate 

●● Checking names of product parts
●● Checking options

2. Checking the Placement Environment
●● Checking the placement environment
●● Checking placement location

3. Preparing a Printer
●● Unpacking
●● Removing cushioning materials
●● Installing consumables
●● Loading paper
●● Turning on/off the power
●● Installing options
●● Test printing from the printer

4. Connecting to a Computer

Connecting through network Connecting through USB

For Windows
For Macintosh

For Windows For Macintosh
Connecting through Bonjour

Specifying an IP address 
on the operator panel

Connecting to a computer

Installing a printer driver on a computer

Adding printers on a computer Adding printers on a 
computer

Test printing from a computer
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●● Checking Products
This section gives an overview of the printer.

Checking Package Contents

Check that you have everything shown below.

CAUTION It may cause injury!

●● At least two people are needed to lift the printer 
safely because it weighs about 37 Kg or 40 Kg.

Reference

●● For details on how to open the package, refer to 
“Unpacking” P.17.

●● Printer

●● Four image drums (black, yellow, magenta 
and cyan)

●● Four starter toner cartridges (black, yellow, 
magenta and cyan)

Note

●● For the C models, the starter toner cartridges are 
installed in the image drums, which are installed in 
the machine before shipment.  
The starter toner cartridge is not installed in the ES 
models. Install the toner cartridge that is included in 
this machine. Refer to “Replacing the Image Drum” 
P.108.

●● Quick Guide

●● Software DVD-ROM

●● AC cord

Note

●● An Ethernet cable and USB cable are not supplied with 
your printer. Procure them separately.

●● Packaging and cushioning material are needed if 
transporting the printer. Do not throw them away.
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●● Operator Panel
This section explains the names and functions of components on the operator panel and how to enter 
text.

1

34

5

567

8

12

13 10

11

9

2

No. Name Function
1 Display screen Displays operating instructions and the status of the printer.
2 <ON LINE> button Switches between on line and off line modes.
3 <CANCEL> button Cancels the current print immediately.
4 <ENTER> button Confirms the highlighted item.
5 <SCROLL> button Selects the menu or scrolls the screen.
6 <BACK> button Returns to the previous screen.
7 <HELP> button Displays the help screen. To close, press the <HELP> button, <BACK> 

button, or <CANCEL> button.
8 <POWER SAVE> button ●● Enters or exits the power saving mode.

●● Exits the deep sleep mode.
Lights up green in the power save mode and blinks green in the deep sleep mode.

9 Numeric Keypad ●● Enters numbers.
●● Enters alphabetical characters and symbols.

A password can be entered only with a numeric keypad.
10 <Fn> key Displays the equipment setting menu screen with a shortcut function.
11 <CLEAR> key Executes the following actions according to the entered items when pressed 

or held down.
●● Minimizes a setting value.
●● Enters zero for a setting value.
●● Deletes a character.
●● Cancels a selected item.

Returns to the previous settings. Not available when entering an IP address.
12 <READY> indicator Lights up green in on line mode and turns off in off line mode.
13 <ATTENTION> indicator Lights up or blinks orange when an error occurs in the device.

How to Use the Numeric Keypad

Use to enter numbers and characters.

Each time a numeric key is pressed, entered 
numbers or characters are changed cyclically in 
the following order:

<1>: 1
<2>: 2 → a → b → c → A → B → C → 2
<3>: 3 → d → e → f → D → E → F → 3
<4>: 4 → g → h → i → G → H → I → 4
<5>: 5 → j → k → l → J → K → L → 5
<6>: 6 → m → n → o → M → N → O → 6
<7>: 7 → p → q → r → s → P → Q → R → S → 7
<8>: 8 → t → u → v → T → U → V → 8

<9>: 9 → w → x → y → z → W → X → Y → Z → 9
<0>: 0
The functions of < > and <C> keys are the 
followings:

< >: Function key (Available only when the 
standby screen is displayed.)

<C>: Deletes a character when entering a 
password.

To enter “abc” for example, 
press <2> → <2> → <ENTER> button → <2> 
→ <2> → <2> → <ENTER> button → <2> → 
<2> → <2> →  <2> → <ENTER> button.



- 13 -

Operator Panel

1

1
.	

S
etu

p

How to Use the Function Key

Press numeric keys after pressing the <Fn> 
key when the message “Ready To Print” 
appears on the display screen. The function 
menu corresponding to the number entered is 
displayed.

1	 Press the <Fn> key.

2	 Press the numeric keys (0-9) to display 
the desired function item and press the 
<ENTER> button.

3	 The setting screen of the selected 
function is displayed. Check or change 
the settings.

Function Menu List

Function No. Function menu
1 Shared Print
2 Private Print
10 Paper Size (Tray 1)
11 X Dimension (Tray 1)
12 Y Dimension (Tray 1)
13 Media Type (Tray 1)
14 Media Weight (Tray 1)
20 Paper Size (Tray 2)*
21 X Dimension (Tray 2)*
22 Y Dimension (Tray 2)*
23 Media Type (Tray 2)*
24 Media Weight (Tray 2)*
30 Paper Size (Tray 3)*
31 X Dimension (Tray 3)*
32 Y Dimension (Tray 3)*

Function No. Function menu
33 Media Type (Tray 3)*
34 Media Weight (Tray 3)*
40 Paper Size (Tray 4)*
41 X Dimension (Tray 4)*
42 Y Dimension (Tray 4)*
43 Media Type (Tray 4)*
44 Media Weight (Tray 4)*
80 Paper Feed
90 Paper Size (MP Tray)
91 X Dimension (MP Tray)
92 Y Dimension (MP Tray)
93 Media Type (MP Tray)
94 Media Weight (MP Tray)
95 Tray Usage (MP Tray)
100 Configuration
101 Network
102 Usage Report
103 Error Log
200 Power Save Time
201 Sleep Time
202 Auto Power Off Time
210 Error Report
220 Print Position Adjust (MPTray)
221 Print Position Adjust (Tray 1)
222 Print Position Adjust (Tray 2)*
223 Print Position Adjust (Tray 3)*
224 Print Position Adjust (Tray 4)*
230 Paper Black Setting
231 Paper Color Setting
232 Trans. Black Setting
233 Trans. Color Setting
234 SMR Setting
235 BG Setting
236 Drum Cleaning
237 Hex Dump
300 Adjust Density
301 Adjust Registration
302 Print Color Tuning Pattern
310 Cyan Density
311 Magenta Density
312 Yellow Density
313 Black Density

* �An error results when the option item selected 
is not currently installed.
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Names of Components

1

2

3

4

5

6

7

8

8

No. Name
1 Front cover
2 Front cover open lever
3 Operator panel
4 Power switch
5 Output tray
6 Multipurpose tray
7 Tray 1
8 Air vents

9

10

11

12
13

14

15

No. Name
9 Output tray open button
10 Toner cartridge  

Image drum (K: black)
11 Toner cartridge  

Image drum (Y: yellow)
12 Toner cartridge  

Image drum (M: magenta)
13 Toner cartridge  

Image drum (C: cyan)
14 Fuser unit
15 LED head (four heads)

Note

●● In the case of the ES models, toner cartridges are not 
installed in the Image drums.

16

17

18

No. Name
16 Multipurpose tray
17 Paper set cover
18 Wireless LAN module cover

19

23

20

21
22

No. Name
19 Rear output tray
20 AC power socket
21 Interface part
22 Access cover
23 Duplex unit (Only for the model of the name 

with dn or ES)

●● Interface part

24

25

26

No. Name
24 Accessory connector
25 USB interface connection
26 Network interface connection
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Available Options

The following options are available for your 
printer:

●● Additional tray unit (tray 2/3/4)

●● Additional RAM (256 MB or 512 MB)

●● 16 GB SD memory card kit

●● Wireless LAN module
Reference

●● For details on how to install the options, refer to 
“Installing Options” P.23.

●● An SD memory card kit is used for functions such as a 
storage for spooling when copying sectors, saving secure 
print/encrypted print data, and as a storage destination 
for form data. For information on secure print, encrypted 
secure print and form data storage functions, please refer 
to the User’s Manual (Advanced).

Note

●● C813/C823 is available only Tray2.
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●● Checking the Placement Environment

Placement Environment

Your printer must be placed in the following 
environment:

Temperature: 10 - 32°C

Humidity: 20% - 80% RH 
(relative humidity)

Maximum 
wet bulb 
temperature:

25°C

Recommended 
environment: 17 - 27°C, 50 - 70 % RH

Note

●● Be careful of condensation. It may cause a malfunction.

●● If placing your printer in a location where the humidity of 
the surrounding air is less than 30% RH, use a humidifier 
or antistatic mat.

WARNING

●● Do not install near high temperature or the fire.
●● Please do not install in a place from which a 
chemical reaction is started (laboratory etc.).

●● Do not install near the inflammable solution, such 
as alcohol and thinner.

●● Do not install in the place which the small child's 
hand reaches.

●● Do not install in an unstable place (the shaky 
stand, leaning place, etc.).

●● Do not install in a place many humidity, dusty and 
the place where direct rays hit.

●● Do not install in the environment of briny air and 
corrosive gas.

●● Do not install in a place with much vibration.
●● Do not install in a place where the ventilation hole 
of the printer is closed.

CAUTION

●● Do not place directly on a rug or carpet with long 
strands.

●● Do not install in a closed room with poor 
ventilation and circulation.

●● If you use the printer in a small room for a long 
time, please make sure that you ventilate the 
room.

●● Install away from strong magnetic fields and 
sources of noise.

●● Install away from monitors or TVs.

Placement Space

Place your printer on a flat surface that is wide 
enough that the printer’s feet securely on the 
surface.

Allow for enough room around your printer as 
shown in the images below.

●● Top view

20 cm

20 cm

100 cm60 cm

●● Side view

70 cm
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●● Preparing Your Printer
This section explains how to unpack your printer and how to turn it on and off.

Unpacking

CAUTION It may cause injury!

●● At least two people are needed to lift the printer 
safely because it weighs about 37 Kg or 40 Kg.

Note

●● Be sure to use the consumables or maintenance units 
provided with this printer at first. Otherwise, the life of the 
consumables or maintenance units may not be displayed 
correctly, or you may not be able to use them later.

●● The image drum (the green tube) is very delicate. Handle 
it carefully.

●● Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

●● Packaging and cushioning material are needed if 
transporting the printer. Do not throw them away.

1	 Remove your printer from the box and 
remove all cushioning materials and the 
plastic bag from your printer.

2	 Remove the two strips of protective tape 
(1) at the back of your printer.

1

Installing Consumables

1	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.
Note

●● Open the front cover gently. If opening rapidly, an MP 
tray may open.

1

2

2	 Press the output tray open button (3) 
and open the output tray (4).

3
4

3	 Take out all four image drums from the 
printer.
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4	 Remove the protective sheets from four 
image drums.

(1)	 Place an image drum on a 
newspaper. Remove a tape (6) stuck 
on a protective sheet (5) and open it.

6

5

(2)	 Pull out a protective sheet to the 
direction of the arrow.

Note

●● Do not turn the blue lever of the toner cartridge.

5	 Put all four image drums back into a 
printer.

6	 Turn the blue lever (7) of the toner 
cartridge backward until its top aligns on 
the  mark.
Turn the levers of all four 4 toner cartridges.

7

7	 Close the output tray (4) by pushing the 
both sides of the cover firmly.

4

8	 Close the front cover (2).
Note

●● The front cover cannot be closed securely if the 
output tray is not closed.

●● When the error message that the top or front cover 
is open does not disappear from the operator panel’s 
display screen, make sure they are closed securely.

2
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Loading Paper

Reference

●● Please refer to “Supported Paper” P.48 for information 
on how to load paper into the printer.

1	 Pull out the paper tray (1).

1

2	 Set the paper size dial (2) to match the 
loading paper size. 
Set the dial to [A4 ] when loading the A4 size 
paper with a landscape orientation.

2

3	 Slide the paper guide (3) and paper 
stopper (4) to the size of paper to be 
loaded.

3

4

Note

●● When loading the A6 size paper, move the paper 
stopper (4) forward and remove it once, then install 
it on the metal part.

4

4	 Flex paper back and forth, and then fan 
it. Straighten the edges of the paper 
stack on a level surface.
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5	 Load paper with the print side face down 
and press it from above.
Note

●● Do not load paper exceeding the [ ] mark (5) of the 
paper guide.

5

6	 Secure the loaded paper with the paper 
guide.

7	 Check if a size of loaded paper matches 
the setting of paper size dial.

8	 Return the paper tray to the printer.
Memo

●● If loading a paper that you cannot select the 
size with a paper size dial options, set the dial to 
[Other], and then set a paper size on the operator 
panel.

Turning On/Off the Power

Power Supply Conditions

The power supply must meet the following 
conditions:

Voltage: 110 - 127 VAC (Range 99 - 140 VAC)
220 - 240 VAC (Range 198 - 264 VAC)

Frequency: 50/60 Hz ± 2%

Note

●● If the power supply is unstable, use a voltage regulator.

●● The maximum power consumption of this printer is  
1400 W. Ensure that the power supply is sufficient to 
operate this printer.

●● We do not guarantee operation where an uninterruptible 
power system (UPS) or inverter is used. Do not use an 
uninterruptible power system (UPS) or inverter.

WARNING
There is a risk of getting 
an electric shock and/or 

causing fire.

●● Be sure to turn off the power supply switch when 
attaching or removing the AC cable and earth wire.

●● Be sure to connect an earth wire to the grounding 
terminal of exclusive use.

●● Please do not connect with the ground of a water pipe, 
a gas pipe, and a telephone wire, and a lightning rod by 
any means.

●● Make sure to connect with the ground terminal before 
connecting the power cord to the power supply plug.

●● Be sure to plug in and unplug the AC cable while holding 
on to the power supply plug.

●● Insert the AC cable plug completely into the wall socket 
securely.

●● Do not touch the power cord, or printer, if your hands 
are wet.

●● Install a power cord in the place which is not stepped on, 
and do not place a thing on a power cord.

●● Do not use the cord tied in a bundle.
●● Please do not use the damaged power cord.
●● Do not use multi-outlet adapters.
●● Do not connect this printer and other electric products 
to the same wall socket. If it connects simultaneously 
with an air conditioner, copier, shredder, etc. Especially, 
a printer may incorrect-operate by the electric 
noise. When you connect with the same wall socket 
unavoidably, please use a commercial noise filter or a 
commercial noise cut transformer.

●● Use the attached power cord and insert it directory with 
the ground terminal. Do not use the power cord for other 
product for the printer.

●● Do not use an extension cord. When you use it 
unavoidably, use the thing more than rated 15 A.

●● Use of an extended code may not operate a printer 
normally by AC voltage descent.

●● During printing, do not shut off a power supply or do not 
pull out a power supply plug.

●● When you use it neither for consecutive holidays nor a 
travel for a long time, pull out a power cord.

●● Do not use attached power cord to the other products.
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Turning On the Power

1	 Plug the AC cord (1) into the AC power 
socket of your printer.

1

2	 Plug the AC cord into the electric socket.

3	 Hold down the power switch (2) for 
about 1 second to turn on the power.

2

The Power switch LED indicator lights up when 
the printer turns on.

The message “Ready To Print” is displayed in 
the operator panel once printer is ready.

Turning Off the Power

1	 Hold down the power switch (1) for 
about a second.
The message “Shutting down. Please wait. 
Printer will turn off automatically” appears 
in the operator panel, and the power switch 
indicator blinks every 1 second. Then the printer 
turns off automatically and the power switch 
indicator goes out.

Note

●● It may take about 5 minutes to turn off the power. 
Wait until it turns off.

●● Holding down the power switch for more than 5 
seconds turns off printer forcibly. Only perform 
this procedure when a problem occurs. For printer 
problems, refer to “Other Issues” P.93.

1

�� When the Printer is Not Used for a 
Long Time

When the printer is not used for a long time due 
to consecutive holidays or when on vacation, or 
when changing or attaching parts in repair or 
maintenance, unplug the AC cord. 

Memo

●● The printer will not be functionally impaired even if left 
unplugged for a long time (more than 4 weeks).
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Power Save Mode and Deep Sleep Mode

Two-phase power conservation enables you to 
save on power consumed by the printer.

�� Power Save Mode
When your printer is not used for a certain 
period of time, it automatically enters the power 
save mode to reduce the power consumption.

You can enter the power save mode manually 
by pressing the <POWER SAVE> button on the 
operator panel.

The <POWER SAVE> button lights up green 
while in this mode.

Memo

●● By factory default, the time interval before entering the 
power save mode is set to 1 minute. For how to change 
the time that elapses before the printer enters the power 
save mode, refer to “Setting the Time that Elapses Before 
Entering the Power Save Mode” P.65.

�� Deep Sleep Mode
Your printer goes from the power save mode to 
the deep sleep mode after a set period of time.

The <POWER SAVE> button blinks while in the 
deep sleep mode.

Note

●● The printer does not enter the deep sleep mode if an error 
occurs.

Memo

●● By factory default, the time interval before entering the 
deep sleep mode is set to 15 minutes. For how to change 
the time that elapses before the printer enters the deep 
sleep mode, refer to “Setting the Time that Elapses Before 
Entering the Deep Sleep Mode” P.66.

Reference

●● For more detailed information on deep sleep mode, please 
refer to the User’s Manual (Advanced).

�� Restoring a Printer from the 
Power Saving Mode

To restore the printer from the power save 
mode or the deep sleep mode, press the 
<POWER SAVE> button on the operator panel.

Memo

●● When the printer receives a print job from a computer or 
other devices, it is restored automatically.

Auto Power Off Function

When a certain period of time elapses after 
printing, this printer will turn off automatically.

Memo

●● The factory default setting for time that elapses before the 
printer power turns off automatically is 4 hours.

●● For how to change the time that elapses before the 
printer power turns off automatically, refer to “Settings for 
Turning Power Off Automatically (Auto Power Off)” P.69.

Note

●● In the factory default setting, the auto power off mode 
is disabled during network connection. To enable the 
auto power off mode during network connection, refer to 
“Settings for Turning Power Off Automatically (Auto Power 
Off)” P.69.



- 23 -

Preparing Your Printer

1

1
.	

S
etu

p

Installing Options

This section explains how to install options on 
your printer. The following options are available:

●● Additional tray unit (Tray 2/3/4)

●● Additional RAM (256 MB or 512 MB)

●● 16 GB SD memory card kit

●● Wireless LAN module
Note

●● Be sure to turn off your printer and unplug the AC cord 
and Ethernet or USB cable before installing options. 
Installing options while your printer is turned on may 
damage your printer and options.

Memo

●● After installing options, set the option settings with a 
printer driver. Refer to “When Adding Options” P.46.

Installing an Additional Tray Unit

Install an optional additional tray unit when 
you want to increase the paper capacity of your 
printer. You can install up to three additional tray 
units. After installation, you need to configure 
the printer driver settings.

N35110A

Reference

●● For specifications of the additional tray unit, refer to 
“Supported Paper” P.48.

CAUTION It may cause injury!

●● At least two people are needed to lift the printer 
safely because it weighs about 37 Kg or 40 Kg.

1	 Turn off your printer, and then unplug 
the AC cord and the Ethernet or USB 
cable.
Reference

●● “Turning Off the Power” P.21

2	 Stack an additional tray aligning a back 
side of each tray.

3	 Place a printer on the additional trays 
gently aligning the back sides of a 
printer and the additional trays.

4	 Plug the AC cord and Ethernet or USB 
cable into your printer, and then turn on 
the power switch.
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●● Do not apply force to the printer’s output tray 
while it is open.

●● Do not apply downward force to the paper tray 
while it is pulled out.

●● Do not apply force to the printer from the back 
while the paper tray is pulled out.

Installing Additional RAM

Install additional RAM to increase the memory 
capacity of your printer in cases such as if 
memory overflow or the collate print errors 
occur. Your printer supports 256 MB and 512 MB 
RAM.

Note

● Use  only genuine OKI products. The performance cannot 
be guaranteed when using other products.

●● The static electricity may damage parts. Discharge the 
static electricity from your body by touching grounded 
metallic parts, etc., before work.

●● For C843/ES8443, it is necessary to replace the installed 
256 MB RAM with a 512 MB RAM.

Memo

●● For banner printing, installing additional memory is 
recommended.

1	 Turn off your printer, and then unplug 
the AC cord and Ethernet or USB cable.
Reference

●● “Turning Off the Power” P.21

2	 Open the access cover (1) on the right 
side of a printer.

1



- 25 -

Preparing Your Printer

1

1
.	

S
etu

p

3	 Slide the metal plate (2) upward to 
remove.
Note

●● If the SD memory card socket is attached, remove 
the SD memory card.

(1)	 Put your finger in the recess of the 
metal plate (2), and slide it upward.

2

(2)	 Pinch the lower part of the metal 
plate (2), and pull it forward.

2

4	 Make sure the LED (3) indicated by the 
arrow turns off. If it is lit, wait until it 
turns off.

3

5	 Insert the additional RAM (4) into the 
slot and fix it by pushing it toward the 
printer. 
Note

●● Be sure to check a direction of an additional RAM. 
The additional RAM has small dents on its connector, 
which are fitted with a connector of a slot.

4

6	 Install the metal plate (2).

(1)	 First, insert the upper part of the 
metal plate (2) in the printer, then 
install the metal plate.

2

(2)	 While holding the lower part of the 
metal plate (2), slide the metal plate 
downward and secure it.

2

Note

●● Attach the SD memory card socket before installing 
the metal plate if the SD memory card socket was 
attached to the printer.
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7	 Close the access cover (1).

1

8	 Plug the AC cord and Ethernet or USB 
cable into your printer, and then turn on 
the power switch.

9	 Press the scroll button  or  on the 
operator panel.

10	 Press the scroll button  to select 
[Configuration] and press the 
<ENTER> button.

11	 Press the scroll button  several times 
to select [System] and press the 
<ENTER> button.

12	 Press the scroll button  several times to 
select [RAM] and press the <ENTER> 
button. 

13	 Check that the value of [RAM] has 
increased.

RAM

-- For memory expanded to 256 MB, it is 
[512 MB]; for memory expanded to 512 
MB, it is [768 MB].
Note

●● If the value of [RAM] has not increased, turn off 
your printer and unplug the AC cord and Ethernet or 
USB cable, and then reinstall the additional RAM.

14	 Press the <ON LINE> button.
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Installing the 16-GB SD Memory 
Card Kit

For storing print data or a secure printing, install 
the SD memory card kit.

SD memory socket

SD memory card

Memo

●● The SD memory socket is attached to the SD memory 
card. 

Note

●  Use only genuine OKI products. The performance cannot
be guaranteed when using other products.

●● The static electricity may cause damage to the parts. 
Discharge the static electricity in your body by touching 
grounded metallic parts, etc. before work.

●● You can not use the SD memory card with the protection 
switch for accidental overwriting locked. Make sure to 
release the lock.

1	 Turn off your printer, and then unplug 
the AC cord and Ethernet or USB cable.
Reference

●● “Turning Off the Power” P.21

2	 Open the access cover (1).

1

3	 Remove the metal plate (2) by sliding it 
upward.

(1)	 Put your finger in the recess of the
metal plate (2), and slide it upward.

2

(2)	 Pinch the lower part of the metal
plate (2), and pull it forward.

2

4	 Make sure the LED (3) indicated by the 
arrow turns off. If it is lit, wait until it 
turns off.

3
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5	 Install the SD memory card (4) into the 
SD memory card socket (5).

4

5

6	 Install the SD memory socket to the 
printer with the screw (6) and tab (7) for 
the SD memory card socket and attach 
the connector (8).

6

7

8

7	 Install the metal plate (2).

(1)	 First, insert the upper part of the 
metal plate (2) in the printer, then 
install the metal plate.

2

(2)	 While holding the lower part of the 
metal plate (2), slide the metal plate 
downward and secure it.

2

8	 Close the access cover (1).

1

9	 Plug the AC cord and Ethernet or USB 
cable into your printer, and then turn on 
the power switch.

10	 Press the scroll button  or  on the 
operator panel.

11	 Press the scroll button  to select 
[Configuration] and press the 
<ENTER> button.
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12	 Press the scroll button  several times 
to select [System] and press the 
<ENTER> button.

13	 Press the scroll button  several times 
to select [SD Card] and press the 
<ENTER> button.

14	 Check that the value of [SD Card] is 
[16 GB].

SD Card       1/1
15GB[F52]

Note

●● [15 GB] may be displayed in [SD Card]. This is not 
an error.

●● If the value of [SD Card] has not increased, turn off 
your printer and unplug the AC cord and Ethernet or 
USB cable, and then reinstall the SD memory card.

15	 Press the <ON LINE> button.

Installing the Wireless LAN module

1	 Turn off your printer, and then unplug 
the AC cord.

2	 Open the Wireless LAN module cover (1) 
on the right side of a printer.

(1)

3	 Pull out the connector, and plug it into 
the Wireless LAN module.
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4	 Install the Wireless LAN module.

5	 Close the Wireless LAN module cover.

6	 Plug the AC cord.

7	 Turn on your printer while pressing the 
<ENTER> button.

8	 Press the <ENTER> button.

9	 Enter the administrator password, and 
press the <ENTER> button.
The factory default password is “999999”.

10	 Press the scroll button to select 
[Wireless Module] and press the 
<ENTER> button.

11	 Press the scroll button to select 
[Enable] and press the <ENTER> 
button.

12	 Press the <ON LINE> button.

Test Printing from the Printer

Check that you can print with the printer. 
Check the detailed settings and status of your 
printer by printing the contents of the settings 
(Configuration).

Note

●● When a printer is in the power saving mode, press the 
<POWER SAVE> button to restore from the mode.

1	 Press the <Fn> key on the operator 
panel.

2	 Enter “100” using the numeric keypad 
and press the <ENTER> button.

3	 Press the <ENTER> button as 
[Execute] is selected.

Configuration   1/1
Execute

4	 After finishing a print of printer settings, 
a setup for printing from a printer 
completes.
Reference

●● You can also print reports and lists for each function. 
Refer to the User’s Manual (Advanced).
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●● Connecting to a Computer
This section explains how to connect your printer to a computer and install a printer driver software 
using the provided “Software DVD-ROM”.

Prepare a computer with a DVD drive.

�� Connection Method
You can select either of the following connection methods:

●● “Network Connection” P.32

●● “USB Connection” P.42

�� Product Requirements
Your printer supports the following operating systems:

●● Windows 10/Windows 10 (64bit Version)

●● Windows 8.1/Windows 8.1 (64bit Version)

●● Windows 8/Windows 8 (64bit Version)

●● Windows 7/Windows 7 (64bit Version)

●● Windows Vista/Windows Vista (64bit Version)

●● Windows Server 2012 R2

●● Windows Server 2012

●● Windows Server 2008 R2

●● Windows Server 2008/Windows Server 2008 (x64 Version)

●● Mac OS X 10.8.5 to 10.11

�� Types of Drivers
The types of the drivers that can be installed are as follows.

●● For Windows

Type Description
PCL The PCL printer driver is suitable for printing of business documents.
PS The PS printer driver is suitable for printing of documents including PostScript fonts and EPS data.

●● For Mac OS X

Type Description
PS The PS printer driver can be also used for normal printing. The PS printer driver do not support 

C813/C823. 
PCL The PCL printer driver can be also used for normal printing. The PCL printer driver support only 

C813/C823.

Note

●● Depending on the printer driver version or the version of Windows or Mac OS X, the description may be different.
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Network Connection

Perform the following procedure to connect your 
printer to a computer via network.

Connecting an Ethernet Cable

Be sure to connect your printer to a network 
with an Ethernet cable before driver installation.

1	 Prepare an Ethernet cable (1) and a hub 
(2).
Prepare an Ethernet cable (category 5, twisted 
pair, straight) and a hub separately.

1

2

2	 Turn off your printer and computer.
Reference

●● “Turning Off the Power” P.21

3	 Plug one end of the Ethernet cable into 
the network interface connection (3) on 
the back of the printer.

4	 Plug the other end of the Ethernet cable 
into the hub (2).

3

2

Connecting in Wireless LAN 
(Infrastructure Mode) (Optional)

Note

●● In a wireless LAN environment, the machine enters sleep 
mode, but does not enter deep sleep mode.

●● Do not place any devices (especially microwave 
ovens or digital cordless telephones) that emit weak 
electromagnetic waves near the machine.

●● Install the machine near a wireless LAN access point or 
wireless device with no obstacles between them (the 
distance should be within 30 m).

●● Wireless connections may be difficult if there is any metal, 
aluminum framed windows, or reinforced concrete walls 
between the machine and the wireless LAN access point.

●● Wireless LAN connections may have slower transmission 
speeds, depending on the environment, than wired LAN 
or USB connections. We recommend using a wired LAN or 
a USB connection to print large amounts of data, such as 
photographs.

�� To choose a valid default gateway

1	 Press the scroll button  several times 
to select [Admin Setup] and press the 
<ENTER> button.

2	 Enter the administrator password using 
the numeric (0-9) keys, and press the 
<ENTER> button.
The factory default password is “999999”.

3	 Press the scroll button  several times 
to select [Network Setup] and press 
the <ENTER> button.

4	 Press the scroll button  several times 
to select [Enabling Default Gateway] 
and press the <ENTER> button.

5	 Press the scroll button  to select 
[Wireless(Infrastructure)].

6	 Press the <ENTER> button.

�� Connecting Using WPS
If the wireless LAN access point supports WPS, 
the connection to the wireless LAN can be made 
easily by using the easy setup button (WPS 
button).

Follow the procedure below for the setup.
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1	 Confirm the position of the easy setup 
button and when to press the button 
by referring to the user manual of the 
wireless LAN access point.

2	 Confirm that the wireless LAN access 
point has been activated and is 
functioning normally.

3	 Turn on the printer.

4	 Press the scroll button  several times 
to select [Wireless(Infrastructure) 
Setting], and then press the <ENTER> 
button.

5	 Enter the administrator password using 
the numeric (0-9) keys, and press the 
<ENTER> button.
The factory default password is “999999”.

6	 Press the scroll button  several times 
to select [Automatic setup (WPS)], 
and then press the <ENTER> button.

7	 Select [WPS-PBC], and then press the 
<ENTER> button.

8	 Select [Yes], and then press the 
<ENTER> button.

9	 The Printer starts searching for wireless 
LAN access points. During 2 minutes, 
press the easy setup button for the 
wireless LAN access point for a few 
seconds.

Once “Connection successful” is displayed, 
it indicates that the wireless LAN setup has 
completed.

If “Connection failed” is displayed, repeat the 
procedure from step 4.

If an antenna appears on the upper right corner 
of the operator panel, it indicates that the 
connection is successful.

�� Connecting by Selecting a Wireless 
LAN Access Point from the Control 
Panel

If the wireless LAN access point does not support 
WPS, you can connect by selecting the wireless 
LAN access point you want to use from those the 
machine has detected. To do this, an encryption 
key is required.

1	 Confirm and write down the SSID and 
encryption key by referring to the user 
manual of the wireless LAN access point.
Memo

●● The SSID is also called the network name, ESSID, or 
ESS-ID. 

●● The encryption key is also called the network key, 
security key, password, or pre-shared key. 

2	 Confirm that the wireless LAN access 
point has been activated and is 
functioning normally.

3	 Turn on the printer.

4	 Press the scroll button  several times 
to select [Wireless(Infrastructure) 
Setting], and then press the <ENTER> 
button.

5	 Enter the administrator password using 
the numeric (0-9) keys, and press the 
<ENTER> button.
The factory default password is “999999”.

6	 Press the scroll button  several times to 
select [Wireless Network Selection], 
and then press the <ENTER> button.

7	 The printer starts searching for wireless 
LAN access points. Please wait.

8	 A list of available wireless LAN access 
point SSIDs are displayed. Press  or ,  
select a wireless LAN access point, and 
press the <ENTER> button.
Note

●● If only [Manual Setup] is displayed or the desired 
wireless LAN network SSID is not displayed, follow 
the procedure in “Connecting by Manual Setup from 
Control Panel” to do the settings.

9	 A screen opens in which to input the 
encryption key appropriate to the 
encryption procedure for the selected 
wireless LAN access point; input the 
encryption key.
Memo

●● The encryption key differs depending on the wireless 
LAN access point and security. 

�� If [WPA Pre-shared Key] is displayed

Item Explanation
Encryption 
method

WPA/WPA2-PSK

Encryption key Enter the pre-shared key.
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�� If [WEP Key] is displayed

Item Explanation
Encryption 
method

WEP

Encryption key Input the WEP key.

�� Other settings

Item Explanation
Encryption 
method

Disable

Encryption key Input is not necessary.

10	 The SSID selected in step 7 and 
the encryption method in step 8 
are displayed as security in of the 
confirmation screen. If the SSID is 
the same as the one set up in step 1, 
select [ENTER]:Execute and press the 
<ENTER> button.

Once “Connection successful” is displayed, 
it indicates that the wireless LAN setup has 
completed.

If “Connection failed” is displayed, repeat the 
procedure from step 4.

If an antenna appears on the upper right corner 
of the operator panel, it indicates that the 
connection is successful.

�� Connecting by Manual Setup from 
Control Panel

Configure the wireless LAN access point 
information (SSID, encryption method, and 
encryption key) manually, and connect to the 
wireless LAN.

1	 Check and write down the SSID, the 
encryption method and the encryption 
key by referring to the user manual of 
the wireless LAN access point.
Note

●● When the encryption method is WPA-EAP or WPA2-
EAP, configure from the printer’s web page.

Memo

●● The SSID is also called the network name, ESSID, or 
ESS-ID.

●● The encryption key is also called the network key, 
security key, password, or pre-shared key.

2	 Confirm that the wireless LAN access 
point has been activated and is 
functioning normally.

3	 Turn on the printer.

4	 Press the scroll button  several times 
to select [Wireless(Infrastructure) 
Setting], and then press the <ENTER> 
button.

5	 Enter the administrator password,and 
press the <ENTER> button.
The factory default password is “999999”.

6	 Press the scroll button  several times to 
select [Wireless Network Selection], 
and then press the <ENTER> button.

7	 The printer starts searching for wireless 
LAN access points. Please wait.

8	 A list of available wireless LAN access 
point SSIDs are displayed. Press  or , 
select [Manual Setup] at the end of the 
list, and press the <ENTER> button.

9	 Input the SSID recorded in step 1, and 
press the <ENTER> button.
Note

●● It is case sensitive. Please enter it correctly.

10	 Select the encryption method confirmed 
in step 1, and press the <ENTER> 
button.
Memo

●● The encryption key differs depending on the wireless 
LAN access point and security.

11	 Input the encryption key recorded in 
step 1, and press the <ENTER> button.

12	 Press the <ENTER> button.

Once “Connection successful” is displayed, 
it indicates that the wireless LAN setup has 
completed.

If “Connection failed” is displayed, repeat the 
procedure from step 4.

If an antenna appears on the upper right corner 
of the operator panel, it indicates that the 
connection is successful.
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Installing a Printer Driver  
(for Windows)

To complete the network connection with a 
Windows computer, first set IP addresses for the 
printer, and then install a printer driver on the 
computer.

If there is no DHCP server or BOOTP server on 
the network, you need to manually configure the 
IP address on the computer or printer.

If your network administrator or internet service 
provider specifies an unique IP address for the 
computer and your printer, you need to set the 
IP addresses manually.

Note

●● You need to complete the network setting of the computer 
before this procedure.

●● To complete this procedure, you must be logged in as an 
administrator.

●● When setting an IP address manually, ask the network 
administrator or your internet service provider which 
IP address to use. If the IP address is set wrong, the 
network may go down or Internet access may be disabled.

Memo

●● If configuring a small network consisting of only your 
printer and a computer, set IP addresses as shown below 
(according to RFC1918).

For the computer

IP address : 192.168.0.1 - 254

Subnet mask : 255.255.255.0

Default gateway : not used

DNS server : not used

For the printer

IP address Set : Manual

IP address: 
192.168.0.1 - 254 (select a 
different value from that of the 
computer)

Subnet Mask : 255.255.255.0

Default Gateway : 0.0.0.0

Network Scale : Small

●● To set [Network Scale], press the scroll button  or  
and then select [Admin Setup] > [Network Setup] > 
[Network Scale].

��First, Set the IP address of the printer.

1	 Turn on the printer.

2	 Press the scroll button  or  on the 
operator panel.

3	 Press the scroll button  several times 
to select [Admin Setup], and press the 
<ENTER> button.

4	 Enter the administrator password, using 
the numeric (0-9) keys.
The factory default password is “999999”. Press 
<ENTER> button after each character you input. 

5	 Press the <ENTER> button.

6	 Check that [Network Setup] is selected 
and press the <ENTER> button.
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7	 Press the  to select [IP Address Set], 
and press the <ENTER> button.

8	 If setting the IP address manually, press 
the scroll button  and select [Manual], 
and press the <ENTER> button. 
Proceed to the step 9.

If obtaining the IP address automatically, check 
that [Auto] is selected, and press the <ENTER> 
button. 

Proceed to the step 15.

9	 Press the <BACK> button until 
[Network Setup] is displayed. 
Press the scroll button  to select 
[IPv4 Address], and press the 
<ENTER> button.

10	 Enter the IP address using the numeric 
(0-9) keys, and press the <ENTER> 
button.
To move to the next box, press the <ENTER> 
button.

11	 Press the <BACK> button until 
[Network Setup] is displayed. 
Press the scroll button  to select 
[Subnet Mask], and press the 
<ENTER> button.

12	 Enter the subnet mask in the same 
manner of IP address.
To move to the next box, press the <ENTER> 
button.

13	 Press the <BACK> button until 
[Network Setup] is displayed. 
Press the scroll button  to select 
[Gateway Address], and press the 
<ENTER> button.
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14	 Enter the default gateway address and 
press the <ENTER> button.
To move to the next box, press the <ENTER> 
button.

After entering all settings, press the <BACK> 
button.

Gateway Address
192 . 168.     0. 254

15	 When the setup menu screen is 
displayed, press the <ON LINE> button 
to complete the network settings.

��Next, install the printer driver on the 
computer.

1	 Insert the included “Software DVD-ROM” 
into a computer.

2	 When [AutoPlay] is displayed, click 
[Run Setup.exe].

Memo

●● If the [User Account Control] dialog box is 
displayed, click [Yes].

3	 Select a language from the drop-down 
list.

4	 Read the license agreement, and then 
click [Accept].

5	 Read [Environment advice], and then 
click [Next].

6	 Select [Network] in accordance to the 
connection method of the machine and 
computer, and then click [Next].

7	 Select the model name of the machine, 
and then click [Next].
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8	 Click [Install Optional Software].

Installation starts.

Memo

●● The following software is installed.

-- PCL6 Printer Driver (Including Network Extension 
and Color Swatch Utility)

-- FAQ

●● Install other software from Custom Install

9	 Make sure that the software is 
successfully installed, and then click 
[Printing Test].
Select the printer for test printing, and the click 
[Printing Test]. 
Make sure that the test printing was successful, 
and then click [OK].

10	 Click [Complete].

11	 Click [Next].

If the following dialog box is displayed, click 
[Yes].

12	 Click [Exit].
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Installing a Printer Driver 
(For Mac OS X)

To complete the network connection with a Mac 
operating system, install a printer driver on the 
computer and set your printer as a network 
printer.

Note

●● Disable the anti-virus software before starting this 
procedure.

�� Install the Mac OS X PS printer 
driver (Except C813/C823)

When the installation is complete, print a test 
page in step 14.

1	 Make sure that the machine and a 
computer are connected and the 
machine is turned on.

2	 Insert the “Software DVD-ROM” into a 
computer.

3	 Double-click the [OKI] icon on the 
desktop.

4	 [Drivers] > [PS] > Double-click 
[Installer for OSX].

5	 Enter the administrator password, and 
then click [OK].
Follow the on-screen instructions to complete the 
installation.

6	 Select [System Preferences] from the 
Apple menu.

7	 Click [Printers & Scanners].

8	 Click [+], and select [Add Printer or 
Scanner] when the menu is displayed.

9	 Click [Default].

10	 Select the machine where [Kind] is 
[Bonjour], and then select [OKI C833 
PS] from the [Use].

Connection Printer Name Kind

Network OKI-C833 (last 6 digits of 
MAC address)

Bonjour

USB OKI DATA CORP C833 USB

Memo

●● To change the name, enter a new name into 
[Name:].

11	 Click [Add].

12	 If the installable options configuration 
screen is displayed, click [OK].

13	 Make sure that the machine is added 
to [Printers] and [OKI C833 PS] is 
displayed for [Kind].

Note

●● If [OKI C833 PS] is not displayed for [Kind] 
correctly, click [-], delete the machine from 
[Printers], and then newly perform steps 8 to 12.

14	 Click [Open Print Queue...].

15	 Select [Print Test Page] from the 
[Printer] menu.
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�� Install the Mac OS X PCL printer 
driver (C813/C823 only)

When the installation is complete, print a test 
page in step 14.

1	 Make sure that the machine and a 
computer are connected and the 
machine is turned on.

2	 Insert the “Software DVD-ROM” into a 
computer.

3	 Double-click the [OKI] icon on the 
desktop.

4	 [Drivers] > [PCL] > [C823] > Double-
click [Installer for OSX].

5	 Enter the administrator password, and 
then click [OK].
Follow the on-screen instructions to complete the 
installation.

6	 Select [System Preferences] from the 
Apple menu.

7	 Click [Printers & Scanners].

8	 Click [+], and select [Add Printer or 
Scanner] when the menu is displayed.

9	 Click [Default].

10	 Select the machine where [Kind] is 
[Bonjour], and then select [OKI C823 
PCL] from the [Use].

Types of 
Names

Displayed in the 
Connection

Methods 
List

Network OKI-C823 (last 6 digits of 
MAC address)

Bonjour

USB OKI DATA CORP C823 USB

Memo

●● To change the name, enter a new name into 
[Name:].

11	 Click [Add].

12	 If the installable options configuration 
screen is displayed, click [OK].

13	 Make sure that the machine is added 
to [Printers] and [OKI C823 PCL] is 
displayed for [Kind].

Note

●● If [OKI C823 PCL] is not displayed for [Kind] 
correctly, click [-], delete the machine from 
[Printers], and then newly perform steps 8 to 12.

14	 Click [Open Print Queue...].

15	 Select [Print Test Page] from the 
[Printer] menu.
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Connecting in Wireless LAN 
(AP Mode) (Optional)

The wireless LAN (AP mode) connects directly 
to a wireless terminal (computer, tablet, 
smartphone, etc.) without using a wireless LAN 
access point.

Note

●● You cannot enable wireless LAN (infrastructure) and 
wireless LAN (AP mode) at the same time.

●● Do not place any devices (especially microwave 
ovens or digital cordless telephones) that emit weak 
electromagnetic waves near the machine.

●● Wireless connections may be difficult if there is any 
metal, aluminum framed windows, or reinforced concrete 
walls between the machine and the wireless terminal 
(computer, tablet, smartphone, etc.).

●● Wireless LAN connections may have slower transmission 
speeds than wired LAN or USB connections, depending on 
the environment. We recommend using a wired LAN or a 
USB connection.

Preparing to use the wireless LAN 
(AP mode)

The machine becomes a simple wireless access 
point, and wireless terminals (computer, tablet, 
smartphone, etc.) can connect directly to it.

Before you start, confirm that the wireless 
device you are using supports the following 
environment.

Item Value
Standard IEEE 802.11 b/g/n
Security WPA2-PSK (AES)

Automatic Setup (Push Button)

If the wireless terminal (computer, tablet, 
smartphone, etc.) supports WPS-PBC (push 
button), then you can use the WPS button to 
connect via wireless (AP mode).

Follow the procedure below to connect.

1	 Confirm the position of the WPS button 
in the user’s manual provided with the 
wireless terminal (computer, tablet, 
smartphone, etc.)

2	 Turn on the printer.

3	 Press the scroll button  several times to 
select [Wireless(AP Mode) Setting] , 
and then press the <ENTER> button. 

4	 Enter the Admin password using the 
numeric (0-9) keys, and press the 
<ENTER> button.  
(The default password is 999999.)

5	 Select [Enable], and then press the 
<ENTER> button.

6	 Press the scroll button  to select 
[Automatic Setup (Push Button)], 
and then press the <ENTER> button.

7	 Select [Yes], and then press the 
<ENTER> button.

8	 Start WPS-PBC (push button) on the 
wireless terminal (computer, tablet, 
smartphone, etc.).
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Manual connections

If the wireless terminal (computer, tablet, 
smartphone, etc.) does not support WPS-PBC 
(push button), then you can input the machine’s 
SSID and password into the wireless terminal 
(computer, tablet, smartphone, etc.) to connect.

Follow the procedure below to connect.

1	 Turn on the printer.

2	 Press the scroll button  several times to 
select [Wireless(AP Mode) Setting], 
and then press the <ENTER> button.

3	 Enter the Admin password using the 
numeric (0-9) keys, and press the 
<ENTER> button. 
(The default password is 999999.) 

4	 Select [Enable], and then press the 
<ENTER> button.

5	 Press the scroll button  several times 
to select [Manual Setup], and then 
press the <ENTER> button.

6	 Confirm the [SSID] and [Password] 
that are displayed on the printer.

7	 Input the printer’s [SSID] and 
[Password] that were confirmed in step 
7 for the wireless terminal (computer, 
tablet, smartphone, etc.).

USB Connection

Perform the following procedure to connect your 
printer to a computer via USB.

Connecting a USB Cable

1	 Prepare a USB cable (1).
A USB cable is not supplied with your printer. 
Prepare a USB 2.0 cable separately.

1

Memo

●● Use a USB 2.0 Hi-Speed cable for a USB 2.0 Hi-
Speed connection.

2	 Turn off your printer and the computer.
Reference

●● “Turning Off the Power” P.21

3	 Plug one end of the USB cable into the 
USB interface connector (2) on the back 
of the printer.

4	 Plug the other end of the USB cable into 
the computer’s USB interface connector.

2

Note

●● Do not plug the USB cable into the network interface 
connection. Doing so may cause a malfunction.
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Installing a Printer Driver 
(For Windows)

Note

●● You must be logged in as an administrator to complete 
this procedure.

1	 Insert the included “Software DVD-ROM” 
into a computer.

2	 When [AutoPlay] is displayed, click 
[Run Setup.exe].

Memo

●● If the [User Account Control] dialog box is 
displayed, click [Yes].

3	 Select a language from the drop-down list.

4	 Read the license agreement, and then 
click [Accept].

5	 Read [Environment advice], and then 
click [Next].

6	 Select [USB] in accordance to the 
connection method of the machine and 
computer, and then click [Next].

7	 Select the model name of the machine, 
and then click [Next].

8	 Click [Install Optional Software].

Installation starts.

Memo

●● The following software is installed.

-- PCL6 Printer Driver (Including Color Swatch 
Utility)

-- FAQ

●● Install other software from Custom Install.

9	 Make sure that the software is 
successfully installed, and then click 
[Printing Test].
Select the printer for test printing, and the click 
[Printing Test]. 
Make sure that the test printing was successful, 
and then click [OK].

10	 Click [Complete].
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11	 Click [Next].

If the following dialog box is displayed, click 
[Yes].

12	 Click [Exit].

Installing a Printer Driver 
(For Mac OS X)

Note

●● Disable the anti-virus software before starting this 
procedure.

�� Install the Mac OS X PS printer 
driver (Except C813/C823)

When the installation is complete, print a test 
page in step 14.

1	 Make sure that the machine and a 
computer are connected and the 
machine is turned on.

2	 Insert the “Software DVD-ROM” into a 
computer.

3	 Double-click the [OKI] icon on the 
desktop.

4	 [Drivers] > [PS] > Double-click 
[Installer for OSX].

5	 Enter the administrator password, and 
then click [OK].
Follow the on-screen instructions to complete the 
installation.

6	 Select [System Preferences] from the 
Apple menu.

7	 Click [Printers & Scanners].

8	 Click [+], and select [Add Printer or 
Scanner] when the menu is displayed.

9	 Click [Default].

10	 Select the machine where [Kind] is 
[USB], and then select [OKI C833 PS] 
from the [Use].

Connection Printer Name Kind

Network OKI-C833 (last 6 digits of 
MAC address)

Bonjour

USB OKI DATA CORP C833 USB

Memo

●● To change the name, enter a new name into 
[Name:].
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11	 Click [Add].

12	 If the installable options configuration 
screen is displayed, click [OK].

13	 Make sure that the machine is added 
to [Printers] and [OKI C833 PS] is 
displayed for [Kind].

Note

●● If [OKI C833 PS] is not displayed for [Kind] 
correctly, click [-], delete the machine from 
[Printers], and then newly perform steps 8 to 12.

14	 Click [Open Print Queue...].

15	 Select [Print Test Page] from the 
[Printer] menu.

�� Install the Mac OS X PCL printer 
driver (C813/C823 only)

When the installation is complete, print a test 
page in step 14.

1	 Make sure that the machine and a 
computer are connected and the 
machine is turned on.

2	 Insert the “Software DVD-ROM” into a 
computer.

3	 Double-click the [OKI] icon on the 
desktop.

4	 [Drivers] > [PCL] > [C823] > Double-
click [Installer for OSX].

5	 Enter the administrator password, and 
then click [OK].
Follow the on-screen instructions to complete the 
installation.

6	 Select [System Preferences] from the 
Apple menu.

7	 Click [Printers & Scanners].

8	 Click [+], and select [Add Printer or 
Scanner] when the menu is displayed.

9	 Click [Default].

10	 Select the machine where [Kind] is 
[USB], and then select [OKI C823 PCL] 
from the [Use].

Types of 
Names

Displayed in the 
Connection

Methods 
List

Network OKI-C823 (last 6 digits of 
MAC address)

Bonjour

USB OKI DATA CORP C823 USB
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Memo

●● To change the name, enter a new name into 
[Name:].

11	 Click [Add].

12	 If the installable options configuration 
screen is displayed, click [OK].

13	 Make sure that the machine is added 
to [Printers] and [OKI C823 PCL] is 
displayed for [Kind].

Note

●● If [OKI C823 PCL] is not displayed for [Kind] 
correctly, click [-], delete the machine from 
[Printers], and then newly perform steps 8 to 12.

14	 Click [Open Print Queue...].

15	 Select [Print Test Page] from the 
[Printer] menu.

When Adding Options

If options such as additional tray unit and/or 
SD memory card kit have been installed, use 
following procedures to change printer driver 
settings.

�� For Windows PCL Driver

1	 Click [Start] > [Devices and Printers].

2	 Right-click the [OKI C833] icon and 
select [Printer Properties]. (If you 
have installed multiple printer drivers, 
select [Printer Properties] >[OKI 
C833 PCL6].)

3	 Select the [Device Options] tab.

4	 If using a network connection, select 
[Get Printer Settings]. 
If using a USB connection, enter the 
total number of trays excluding the 
multipurpose tray in [Installed Paper 
Trays]. For example, when three option 
trays are installed, enter “4” as the trays 
1, 2, 3 and 4 are available.

5	 Click [OK].
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�� For Windows PS Driver

1	 Click [Start] > [Devices and Printers].

2	 Right-click the [OKI C833] icon and 
then select [Printer Properties]. (If 
you have installed multiple printer 
drivers, select [Printer Properties] > 
[OKI C833 PS].)

3	 Select the [Device Settings] tab.

4	 If using a network connection, select 
[Get installed options automatically] 
under [Installable Options], and then 
click [Setup]. 
If using a USB connection, select 
an appropriate number of trays in 
[Available Trays] under [Installable 
Options].

5	 Click [OK].

�� For Mac OS X Driver

1	 Select [System Preferences] from the 
Apple menu.

2	 Click [Printers & Scanners].

3	 Select the name of your printer and then 
click [Options & Supplies].

4	 Select the [Options] tab.

5	 Select the number of available trays in 
[Available Tray], and then click [OK].
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2.	Printing Basic Operation
This chapter describes how to print documents from a computer.

●● Supported Paper

Supported Paper Types

For high-quality printing, be sure to use paper types that satisfy requirements such as those for 
material quality, weight, and surface finish. Please use digital photo print paper.

If not using recommended paper, please check the print quality and the movement of the paper 
sufficiently beforehand to make sure that there are no problems. Your printer supports the following 
types of paper.

Paper Type Paper Size mm (inch) Paper Weight
Plain paper A3 297 x 420 64 to 256 g/m2

For duplex print, 64 to 220 g/m2

Note

●● If the paper size is set at A6, A5, or 
with a paper width narrower than 148 
mm (A5 width), the printing will be 
slower.

A4 210 x 297
A5 148 x 210
A6 105 x 148
B4 257 x 364
B5 182 x 257
B6 128 x 182
B6 Half 64 x 182
Tabloid (11 x 17)
Letter 215.9 x 279.4

(8.5 x 11)
Legal 13" 215.9 x 330.2

(8.5 x 13)
Legal 13.5" 215.9 x 342.9

(8.5 x 13.5)
Legal 14" 215.9 x 355.6

(8.5 x 14)
Executive 184.2 x 266.7

(7.25 x 10.5)
Statement (5.5 x 8.5)
8.5"SQ (8.5 x 8.5)
Folio 210 x 330.2
8K (260 x 368 mm) 260 x 368
8K (270 x 390 mm) 270 x 390
8K (273 x 394 mm) 273 x 394
16K (184 x 260 mm) 184 x 260
16K (195 x 270 mm) 195 x 270
16K (197 x 273 mm) 197 x 273
Custom Size Width:

64 - 297
Length:
90 - 1321

64 to 256 g/m2
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Paper Type Paper Size mm (inch) Paper Weight
Envelope Nagagata #3 120 x 235 Envelopes should be 24lb paper, and 

flap parts of envelopes should be folded.Nagagata #4 90 x 205
Nagagata #40 90 x 225
Yougata #0 120 x 235
Yougata #4 105 x 235
Kakugata #2 240 x 332
Kakugata #3 216 x 277
C4 229 x 324
C5 162 x 229
DL 110 x 220
Com-10 104.8 x 241.3

Index card Index card 76.2 x 127
(3 x 5)

Photo Photo (4 x 6 inch) (4 x 6)
Photo (5 x 7 inch) (5 x 7)

Hagaki Hagaki 100 x 148
Oufuku Hagaki Oufuku Hagaki 148 x 200

Use paper that meets the following conditions*1:

●● Paper that meets the conditions for plain paper.

●● An ink used for a part printing is heat resistant (230°C).
Note

●● When specifying a printing area, please take into account the differences of printing position as followings: 
Print start position: ±2 mm, Paper skew: ±1 mm/100 mm, Image stretch: ±1 mm/100 mm  
(when paper ream weight is 70 kg)

●● This printer cannot print on an ink.

Use paper that meets the following conditions*2:

●● A pigment or an ink used to color paper is heat resistant (230°C). 

●● Paper that has same characteristics with light paper and used for an electronic photo printer.

Paper Recommendations

Your printer will handle a variety of print media, 
including a range of paper weights and sizes.

This section provides general advice on choice of 
media, and explains how to use each type.

The best performance will be obtained when 
using standard 75 - 90 g/m2 paper designed for 
use in copiers and laser printers.

Use of heavily embossed or very rough textured 
paper is not recommended.

Pre-printed stationery can be used, but the ink 
must not offset when exposed to the high fuser 
temperatures used in the printing process.

CAUTION

●● Envelopes should be free from twist, curl or 
other deformations. They should also be of the 
rectangular flap type, with glue that remains 
intact when subjected to hot roll pressure fusing 
used in this type of printer. Window envelopes are 
not suitable.

●● Labels should also be of the type recommended 
for use in copiers and laser printers, in which the 
base carrier page is entirely covered by labels. 
Other types of label stock may damage the printer 
due to the labels peeling off during the printing 
process.
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Storing Paper

Store paper under the following conditions to 
maintain quality.

●● Inside a cabinet or other dry and dark place

●● On a flat surface

●● Temperature: 20°C

●● Humidity: 50% RH (relative humidity)

Do not store in the following locations.

●● Directly on the floor

●● In direct sunlight

●● Near the inside of an exterior wall

●● On an uneven surface

●● Where static electricity may be generated

●● In places that are excessively hot or where 
temperature rapidly changes

●● Near a copier, air conditioner, heater, or duct
Note

●● Do not unwrap the paper until you are ready to use the 
paper.

●● Do not leave paper unwrapped for a long  period. Doing 
so may result in paper handling and print quality issues.

●● Depending on a media you use, usage conditions and a 
storing conditions, a decrease in paper quality or curling 
of the paper may occur.
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Paper Loaded on the Tray

Your printer has two built-in trays (tray 1 and the MP tray) and an additional tray unit (tray 2/3/4).
Refer to the list below to check the supported paper and capacities of each tray.

Note

●● Duplex printing can not be performed on paper indicated with an asterisk (*).

Tray Supported paper size Paper capacity Paper weight
Tray1 ●● A3

●● A4
●● A5
●● A6
●● B4
●● B5
●● B6
●● Tabloid
●● Letter
●● Legal 13”
●● Legal 13.5”
●● Legal 14”
●● Executive
●● Statement*
●● 8.5”SQ
●● Folio
●● 8K (260 x 368 mm)
●● 8K (270 x 390 mm)
●● 8K (273 x 394 mm)
●● 16K (184 x 260 mm)
●● 16K (195 x 270 mm)
●● 16K (197 x 273 mm)
●● Custom Size 

300 sheets 
(when paper weight is 80 g/m2)

●● Light 
(64 to 82 g/m2)

●● Medium Light 
(83 to 90 g/m2)

●● Medium 
(91 to 105 g/m2)

●● Heavy 
(106 to 128 g/m2)

●● Ultra Heavy1 
(129 to 188 g/m2)

●● Ultra Heavy2 
(189 to 220 g/m2)

Tray2/3/4 
(option)

●● A3  
●● A4  
●● A5   
●● B4  
●● B5    
●● Tabloid  
●● Letter  
●● Legal 13”  
●● Legal 13.5”  
●● Legal 14”  
●● Executive   
●● 8.5”SQ  
●● Folio  
●● 8K (260 x 368 mm)
●● 8K (270 x 390 mm)
●● 8K (273 x 394 mm)
●● 16K (184 x 260 mm)  
●● 16K (195 x 270 mm)  
●● 16K (197 x 273 mm)  
●● Custom Size 

530 sheets 
(when paper weight is 80 g/m2)

●● Light 
(64 to 82 g/m2)

●● Medium Light 
(83 to 90 g/m2)

●● Medium 
(91 to 105 g/m2)

●● Heavy 
(106 to 128 g/m2)

●● Ultra Heavy1 
(129 to 188 g/m2)
Note

●● Weight of paper loaded on an 
additional tray unit is 64 to 
176 g/m2.

●● The specified paper weight 
of Ultra Heavy1 is described 
as 129 to 188 g/m2, but the 
printable weight is up to 
176 g/m2.
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Tray Supported paper size Paper capacity Paper weight
MP Tray ●● A3

●● A4
●● A5
●● A6*
●● B4
●● B5
●● B6
●● B6 Half*
●● Tabloid
●● Letter
●● Legal 13”
●● Legal 13.5”
●● Legal 14”
●● Executive
●● Statement*
●● 8.5”SQ
●● Folio
●● 8K (260 x 368 mm)
●● 8K (270 x 390 mm)
●● 8K (273 x 394 mm)
●● 16K (184 x 260 mm)
●● 16K (195 x 270 mm)
●● 16K (197 x 273 mm)
●● Index Card*
●● Photo (4 x 6 inch)*
●● Photo (5 x 7 inch)*
●● Custom Size
●● C4*
●● C5*
●● DL*
●● Com-10*
●● Hagaki*
●● Oufuku Hagaki*

●● 100 sheets 
(when paper weight is 80 g/m2)

●● 10 envelopes

●● Light 
(64 to 82 g/m2)

●● Medium Light  
(83 to 90 g/m2)

●● Medium 
(91 to 105 g/m2)

●● Heavy 
(106 to 128 g/m2)

●● Ultra Heavy1 
(129 to 188 g/m2)

●● Ultra Heavy2 
(189 to 220 g/m2)

●● Ultra Heavy3 
(221 to 256 g/m2)
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●● How to Print from the Tray
The following procedure explains how to load paper in tray 1 or tray 2/3/4 (option).

Memo

●● This procedure explains to load paper in tray 1. The same procedure is applied to tray 2/3/4.

1	 Pull out the paper tray (1).

1

2	 Set the paper size dial (2) to match the 
size of the paper to be loaded.
Set the dial to [A4 ] when loading A4 size 
paper in horizontal orientation.

2

3	 Slide the paper guide (3) and paper 
stopper (4) to the size of paper to be 
loaded.

3

4

Note

●● When loading A6 size paper, move the paper stopper 
(4) forward and remove it once, then install it on the 
metal part.

4

4	 Flex paper back and forth, and then fan 
it. Straighten the edges of the paper 
stack on a level surface.

5	 Load paper with the print side face down 
and press it from above.
Note

●● Do not load paper exceeding the [ ] mark (5) of the 
paper guide.

5

6	 Secure the loaded paper with the paper 
guide.

7	 Check if a size of loaded paper matches 
the setting of paper size dial.

8	 Return the paper tray to the printer.
Memo

●● If loading a paper that you cannot select the 
size with a paper size dial options, set the dial to 
[Other], and then set a paper size on the operator 
panel.

9	 Open a file you want to print, and print it.
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●● How to Print from the MP Tray
This procedure explains how to load paper in the MP tray.

Note

●● Do not load paper of different sizes, types or weights at the same time.

●● When adding paper, remove the paper on the MP tray and straighten the edges of both stacks of paper, and then load them 
again.

●● Do not put anything other than paper for printing in the MP tray. 

1	 Open the MP tray (1) forward by 
inserting your fingers into the front 
recesses (2).

2

2

1

2	 Pull out the paper support (3) by holding 
the center part of it.

3

3	 Unfold the sub support (4).

4

4	 Open the paper set cover (5).

5

5	 Adjust the manual feeding paper guide 
(6) to the width of paper to be loaded.

6

6	 Insert the paper with the print side face 
up.
Note

●● Do not load paper exceeding the [ ] mark (7) of the 
paper guide.

7
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ABC

When loading paper vertically or horizontally

Com-10, DL, C5

A
B
C

C4

Memo

●● When loading envelopes in the MP tray, load them face up 
with the orientation noted below.

-- Com-10, DL and C5 are loaded with the flap folded 
and the flap should come to the top side in the feeding 
direction.

-- C4 is loaded with the flap folded and the flap should 
come to the left side in the feeding direction.

Note

●● The paper may be wrinkled or curled after printing.

●● Use paper stored in proper temperature and humidity 
conditions. Do not use paper that is curled or waved 
because of humidity.

●● Do not print on the back side of paper on which other 
printer has printed.

●● Curling of a postcard or an envelope may cause the ink 
absorbing problem. Use paper that is not curled. Correct a 
paper Curling within 2 mm.

●● Printing an envelope with an adhesive flap bent cause the 
ink absorbing problem.

7	 Close the paper set cover (5).

5

If always printing on same size or type paper 
from the MP tray, register the paper on the 
operator panel. If printing once, proceed to the 
step 18. 

Note

●● When a printer is in the power saving mode, press 
the <POWER SAVE> button to restore from the 
mode.

●● Make sure that the message “Ready To Print” is 
displayed in the operator panel. If the message is not 
displayed, press the <ON LINE> button.

8	 Press the <Fn> key.

9	 Enter “90” using the numeric keypad 
and then press the <ENTER> button.

10	 When [Paper Size] is displayed, select 
the size of the loaded paper and then 
press the <ENTER> button.

Reference

●● If [Custom] is selected for [Paper Size], you need 
to register the custom size. For how to register the 
custom size, refer to “Printing in Custom Sizes” 
P.58.
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11	 Press the <BACK> button until 
[MPTray Config] is displayed.

12	 Press the scroll button  to select 
[Media Type] and then press the 
<ENTER> button.

13	 Press the scroll button  to select the 
type of the loaded paper and then press 
the <ENTER> button.

14	 Press the <BACK> button until 
[MPTray Config] is displayed.

15	 Press the scroll button  to select 
[Media Weight] and then press the 
<ENTER> button.

16	 Press the scroll button  to select the 
weight of the loaded paper and then 
press the <ENTER> button.

17	 Press the <ON LINE> button to exit the 
menu mode.

18	 Open the file you want to print, and print 
it by following the procedures below.

For Windows PCL Printer Driver

1	 From the [File] menu, select [Print].

2	 Click [Preferences].

3	 On the [Setup] tab, select a paper size 
from [Size].

4	 Select [Multipurpose Tray] from 
[Source].

5	 Start printing.
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For Windows PS Printer Driver

1	 From the [File] menu, select [Print].

2	 Click [Preferences].

3	 Select the [Paper/Quality] tab.

4	 Select [Multi-Purpose Tray] from 
[Paper Source].

5	 Click [Advanced].

6	 Click [Paper Size] and select a paper 
size from the drop-down list.

7	 Click [OK].

8	 Start printing.

For Mac OS X PS Printer Driver

1	 From the [File] menu, select [Print].

2	 Select a paper size from [Paper Size].

3	 Select [Paper Feed] from the panel 
menu.

4	 Select [All pages From] and then select 
[Multi Purpose Tray].

5	 Start printing.
Memo

●● If setting details are not displayed in the print dialog 
box, click [Show Details] at the bottom of the 

dialog box.

For Mac OS X PCL Printer Driver

1	 From the [File] menu, select [Print].

2	 Select a paper size from [Paper Size].

3	 Select [Setup] from the panel menu.

4	 Select [Multi Purpose Tray] from 
[Paper Source].

5	 Start printing.
Memo

●● If setting details are not displayed in the print dialog 
box, click [Show Details] at the bottom of the 

dialog box.
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●● Printing in Custom Sizes
To load custom size paper, you need to register the width and length of the paper before printing. The 
range of the sizes you can set differs according to the paper tray.

Tray Available size range
Tray1 Width:

105 to 297 mm (4.1 to 11.7 inches)
Length:
148, 182 to 431 mm  
(5.8, 7.2 to 17.0 inches)

Tray 2/3/4 
(Option)

Width:
148 to 297 mm (5.8 to 11.7 inches)
Length:
182 to 431 mm (7.2 to 17.0 inches)

MP tray Width:
64 to 297 mm (2.5 to 11.7 inches)
Length:
90 to 1321 mm (3.5 to 52 inches)

Note

●● [Custom] is displayed only when [Paper Size] is set to 
[Custom].

●● The available size range for duplex printing is the same as 
that for tray 2/3/4.

1	 Press the scroll button  or  on the 
operator panel.

2	 Press the scroll button  several times 
to select [Menus] and press the 
<ENTER> button.

3	 Check that [Tray Configuration] 
is selected and press the <ENTER> 
button.

4	 Press the scroll button  several times 
to select [Tray Config] of the paper 
tray in which you loaded paper and then 
press the <ENTER> button.

5	 Check that [Paper Size] is selected and 
press the <ENTER> button.

6	 Press the scroll button  several times 
to select [Custom] and then press the 
<ENTER> button.

7	 Press the <BACK> button.
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8	 Press the scroll button  to select 
[X Dimension] and then press the 
<ENTER> button.

9	 Enter the paper width value using the 
numeric keypad and then press the 
<ENTER> button.

10	 Press the <BACK> button.

11	 Press the scroll button  to select 
[Y Dimension] and then press the 
<ENTER> button.

12	 Enter the paper length value using the 
numeric keypad and then press the 
<ENTER> button.

13	 Press the <ON LINE> button to exit the 
menu mode.

14	 Specify a custom in the following 
procedures.

For Windows PCL Printer Driver

1	 Click [Start] and select [Devices and 
Printers].

2	 Right-click the Your Printer icon and 
select the type of driver you want to 
specify from [Printing preferences].

3	 On the [Setup] tab, click [Paper Feed 
Options].

4	 Click [Custom Size].

5	 Enter a name and the dimensions.

a	 Enter a name for the new size in the 
[Name] box.

b	 Enter its dimensions in the [Width] 
and [Length] boxes.

6	 Click [Add] to save the custom paper 
size to the list and then click [OK].
	You can save up to 32 custom sizes.

7	 Press [OK] until the [Printing 
preferences] dialog box is closed.

8	 Open the file you want to print.

9	 Select the registered paper size and 
start printing on the print dialog.
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For Windows PS Printer Driver

1	 Click [Start] and select [Devices and 
Printers].

2	 Right-click the Your Printer icon and 
select the type of driver you want to 
specify from [Printing preferences].

3	 On the [Layout] tab, click [Advanced].

4	 Click [Paper Size] and select 
[PostScript Custom Page Size] from 
the drop-down list.

5	 Enter the dimensions in the [Width] and 
[Height] boxes, and press [OK].

 

Note

●● [Offsets Relative to Paper Feed Direction] is not 
available.

6	 Press [OK] until the [Printing 
preferences] dialog box is closed.

7	 Open the file you want to print from the 
application.

8	 Select [PostScript Custom Page Size] 
for a paper size and start printing on the 
printer driver.

For Mac OS X Printer Driver

Note

●● In the Mac OS X printer driver, paper size out of the 
available range can be set, however, image is not correctly 
printed. set paper size within available range.

1	 Open the file you want to print.

2	 From the [File] menu, select [Print].

3	 Select [Manage Custom Sizes] from 
[Paper Size]

4	 Click [+] to add an item to the list of 
custom paper sizes.

5	 Double-click [Untitled] and enter a 
name for the custom paper size.

6	 Enter the dimensions in the [Width] and 
[Height] boxes.

7	 Click [OK].

8	 Configure other settings if necessary and 
then start printing.
Memo

●● If setting details are not displayed in the print dialog 
box, click [Show Details] at the bottom of the 
dialog box.
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��Open the file you want to print, and print 
it in the following procedures.

For Windows PCL Printer Driver

1	 From the [File] menu, select [Print].

2	 Click [Preferences] or [Properties].

3	 On the [Setup] tab, select a paper size 
from [Size].

4	 Select [Multipurpose Tray] from 
[Source].

5	 Start printing.

For Windows PS Printer Driver

1	 From the [File] menu, select [Print].

2	 Click [Preferences] or [Properties].

3	 Select the [Paper/Quality] tab.

4	 Select [Multipurpose Tray] from 
[Paper Source].

5	 Click [Advanced].

6	 Click [Paper Size] and select a paper 
size from the drop-down list.

7	 Click [OK].

8	 Start printing.

For Mac OS X PS Printer Driver

1	 From the [File] menu, select [Page 
Setup].

2	 Select a paper size from [Paper Size] 
and then click [OK].

3	 From the [File] menu, select [Print].

4	 Select [Paper Feed] from the panel 
menu.

5	 Select [All pages From] and then select 
[Multi Purpose Tray].

6	 Start printing.

For Mac OS X PCL Printer Driver

1	 From the [File] menu, select [Page 
Setup].

2	 Select a paper size from [Paper Size] 
and then click [OK].

3	 From the [File] menu, select [Print].

4	 Select [Setup] from the panel menu.

5	 Select [Multi Purpose Tray] from 
[Paper Source].

6	 Start printing.
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●● Paper Output
Your printer outputs to the output tray or rear output tray. Paper types that can be outputted to each 
stacker are as follows.

Output 
Stacker

Supported 
paper type

Paper output 
capacity

Output 
Tray

●● Plain paper
●● Recycled 
paper

●● 200 sheets (when 
paper weight is less 
than 80 g/m2)

Rear 
Output 
Tray

●● Plain paper
●● Recycled 
paper

●● Envelope
●● Index card
●● Label

●● 100 sheets (when 
paper weight is less 
than 80 g/m2)

●● 10 sheets (Ultra 
Heavy paper and 
envelopes) 

Note

●● Do not open or close the rear output tray while printing as 
it may result in a paper jam.

�� Using the Output Tray
Paper is delivered with the print side face down, 
stacked in the order printed. 

Note

●● Check that the rear output tray (1) on the rear side of the 
printer is closed. If the rear output tray is open, paper is 
always outputted to the rear output tray.

1

Memo

●● Open the paper supporter (2) so that the printed papers 
do not fall down from the output tray.

2

�� Using the Rear Output Tray
Paper is delivered with the print side face up, 
stacked opposite the order printed.

1	 Pull the rear output tray (1) on the rear 
side of the printer and open it outward.

1

2	 Unfold the paper support (2).

2

3	 Open the sub support (3).

3
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●● Convenient Print Functions
The following convenient print functions are available. For details, refer to the User’s Manual 
(Advanced).

�� Printing on Postcards, Reply 
Postcards or Envelopes

�� Printing on Labels

�� Printing on Custom Size Paper
You can register customized paper sizes to the 
printer driver so you can print on nonstandard 
paper such as banners.

● Printing on custom size paper

A3

A4

�� Changing the Page Layout
You can change the page layout to multiple print, 
booklet print and poster print etc.

1 2

3 4

12

1
3

5

7
9

11

1 2

3 4

●Multipie print ●Booklet print ●Poster print

�� Duplex Printing
You can print on both sides of a sheet of paper.

1

2

●Duplex prints

�� Scaling to Pages
You can print data formatted for one size page 
onto a different size page without modifying the 
print data.

�� Printing Color Data in 
Monochrome

�� Changing Print Quality 
(Resolution)
You can change the print quality to suit your 
needs.

�� Saving Toner
You can save toner by reducing printing density. A 
toner saving can be set in 3 levels.

When printing in 100 % black, you can also 
select the setting without a toner saving. Amount 
of toner can be saved without affecting any 
readability for small characters. 

●Saving toner

Memo

●● There are many convenient print functions in addition to 
those above. Refer to the User’s Manual (Advanced).
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●● Canceling Printing
Press the <CANCEL> button on the operator 
panel to cancel print jobs being currently printed 
or preparing for a print.

When you press the <CANCEL> button is 
pressed, the following message appears.

To cancel printing, select [Yes] and then press 
the <ENTER> button.

To proceed to printing, select [No] and then 
press the <ENTER> button.

If a printer is not operated for about 3 minutes 
while this message appears, the message will go 
out and printing proceeds.
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●● Setting the Time that Elapses Before Entering the 
Power Save Mode

Note

●● When a printer is in the power saving mode, press the <POWER SAVE> button to restore from the mode.

●● Check if the message “Ready To Print” appears. If the message is not displayed, press the <ON LINE> button.

1	 Press the <Fn> key on the operator 
panel.

2	 Enter “200” using the numeric keypad 
and then press the <ENTER> button.

3	 Press the scroll button  or  to specify 
the time and then press the <ENTER> 
button.

4	 Press the <ON LINE> button.

Memo

●● The power save time can be selected from the followings:

-- [1 minute]

-- [2 minutes]

-- [3 minutes]

-- [4 minutes]

-- [5 minutes]

-- [10 minutes]

-- [15 minutes]

-- [30 minutes]

-- [60 minutes]

* Up to 30 minutes for C813/C823.
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●● Setting the Time that Elapses Before Entering the 
Deep Sleep Mode

Note

●● When a printer is in the power saving mode, press the <POWER SAVE> button to restore from the mode.

●● Check if the message “Ready To Print” appears. If the message is not displayed, press the <ON LINE> button.

1	 Press the <Fn> key on the operator 
panel.

2	 Enter “201” using the numeric keypad 
and then press the <ENTER> button.

3	 Press the  or  to specify the time and 
then press the <ENTER> button.

4	 Press the <ON LINE> button.

Memo

●● The sleep time can be selected from the followings:

-- [1 minute]

-- [2 minutes]

-- [3 minutes]

-- [4 minutes]

-- [5 minutes]

-- [10 minutes]

-- [15 minutes]

-- [30 minutes]

-- [60 minutes]

* Up to 30 minutes for C813/C823.
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Constraints When in Deep Sleep Mode

This section explains constraints when in the deep sleep mode.

The printer may not enter the deep sleep mode if an error is displayed.

Printer Driver Utility Constraints

When the printer goes into the deep sleep mode, the following constraints apply to the printer driver 
and utility functions.

When the printer goes into the deep sleep mode, press the <POWER SAVE> button on the control 
panel and check that the screen displays the message “Ready To Print”.

If the message “Ready To Print” is displayed, the following constraints do not apply.

OS Software Name Constraints When in the 
Deep Sleep Mode

Method of resolving 
other than to press the 

<POWER SAVE>  
button

Windows Driver Installer If there is a connection with the 
network, you cannot automatically 
get printer option information 
when installing a driver.

-
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Network Function Constraints

In the deep sleep mode, the following 
constraints apply to network functions.

�� Does Not Enter the Deep Sleep 
Mode

In the following cases, a printer will not enter 
the deep sleep mode.

●● IPSec is enabled.

●● A TCP connection is established.

E.g.: A connection is established with Telnet or 
FTP.

When the transition time to enter Sleep mode 
or Deep Sleep mode from Power Save mode 
elapses and the connection is disconnected, the 
machine enters Sleep mode.

●● E-mail reception is enabled.

●● Wireless LAN is enabled.

●● Google Cloud Print is enabled.

●● LLTD is enabled.

●● HUB Link Status is 1000BASE-T.

●● IPv6 Global Address is assigned.

�� Cannot Print
In the deep sleep mode, you cannot print with 
the following protocols.

●● NBT

�� Cannot Search/Cannot Specify 
Settings

In the deep sleep mode, you cannot search or 
specify settings with the following functions or 
protocols.

●● NBT

●● PnP-X

●● UPnP

●● MIB*

* You can reference through some supported MIB in the deep sleep 
mode (Get command).

�� Protocols with the Client 
Functions Do Not Work

In the deep sleep mode, the following protocols 
with client functions will not work.

●● E-mail alerts*1

●● SNMP Trap

●● WINS*2

●● SNTP*3

*1 Time that passes in the deep sleep mode is not included in the 
interval for periodic notification by e-mail alert.

*2 Time that passes in the deep sleep mode is not included in the 
intervals between WINS updates. Regular WINS updates are not 
carried out in the deep sleep mode, so the names registered on the 
WINS server may be deleted.

*3 Time that passes in the deep sleep mode is not included in the 
interval between update for NTP servers.



- 69 -

Settings for Turning Power Off Automatically (Auto Power Off)

2

2
.	

Prin
tin

g
 B

asic O
p
eratio

n

●● Settings for Turning Power Off Automatically 
(Auto Power Off)

Note

●● In the factory default, a printer does not enter the auto power off mode while connecting to the network.

Setting the Auto Power Off

To enable the auto power off mode while 
connecting to the network perform the following 
procedure.

1	 Press the scroll button  or  on the 
operator panel.

2	 Press the scroll button  several times 
to select [Admin Setup], and press the 
<ENTER> button.

3	 Enter the administrator password, using 
the numeric (0-9) keys.
The factory default password is “999999”. Press 
the <ENTER> button whenever inputting one 
character.

4	 Press the <ENTER> button.

5	 Press the scroll button  several times 
to select [Power Setup], and press the 
<ENTER> button.

6	 Press the scroll button  several times 
to select [Auto Power Off], and press 
the <ENTER> button.

7	 Press the scroll button  or  to select 
[Enable], and press the <ENTER> 
button.

8	 Press the <ON LINE> button to exit the 
menu mode.
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Setting the Time that Elapses Before 
Entering the Auto Power Off Mode

Note

●● When a printer is in the power saving mode, press the 
<POWER SAVE> button to restore from the mode.

●● Check if the message “Ready To Print” appears. If the 
message is not displayed, press the <ON LINE> button.

1	 Press the <Fn> key on the operator 
panel.

2	 Enter “202” using the numeric keypad 
and then press the <ENTER> button.

3	 Press the scroll button  or  to specify 
the time and then press the <ENTER> 
button.

4	 Press the <ON LINE> button.

Memo

●● The auto power off time can be selected from the 
followings:

-- [1 hour]

-- [2 hours]

-- [3 hours]

-- [4 hours]

-- [8 hours]

-- [12 hours]

-- [18 hours]

-- [24 hours]
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●● Setting the Buzzer
You can set the buzzer volume when a paper jam occurs.

1	 Press the scroll button  or  on the 
operator panel.

2	 Press the scroll button  several times 
to select [Admin Setup], and press the 
<ENTER> button.

3	 Enter the administrator password, using 
the numeric (0-9) keys.
The factory default password is “999999”. Press 
the <ENTER> button whenever inputting one 
character.

4	 Press the <ENTER> button.

5	 Press the scroll button  several times 
to select [Buzzer Setup], and press the 
<ENTER> button.

6	 Press the scroll button  several times 
to select [Paper Jam Error Buzzer 
Volume], and press the <ENTER> 
button.

7	 Press the scroll button  several times 
to select a volume level, and press the 
<ENTER> button.

8	 Press the <ON LINE> button to exit the 
menu mode.



- 72 -

3

3
.

Tro
u
b
lesh

o
o
tin

g

3. Troubleshooting
This chapter provides solutions to the problems you may encounter while operating your printer.

Memo

●● Meanings of symbols in error messages:

-- “%COLOR%” indicates Cyan (C), Magenta (M), Yellow (Y) or Black (K).

-- “%TRAY%” indicates tray 1, tray 2, tray 3, tray 4 or the MP tray.

-- “%COVER%” indicates a front cover or output tray.

-- “%CODE%” indicates a code number displayed in 1 to 3 digits. A code number changes according to an error.

-- “%MEDIA_SIZE%” indicates paper size.

-- “%MEDIA_TYPE%” indicates a paper type.

●● When the message “Please see Help for details” appears on the display screen, you can check an error code and remedy 
error by pressing the <HELP> button on the operator panel.

●● When an Error Message Appears on the Display 
Screen (When the ATTENTION Indicator Lights 
Up/Blinks)

When a printer problem occurs, an error message appears on the display screen and the 
<ATTENTION> indicator on the operator panel lights up or blinks. Check the error message and deal 
with the problem according to the relevant procedure.

When “Please see Help for details” appears on the display screen, press the <HELP> button to display a 
remedy.

Display Screen when the <HELP> button is pressed

When “Please see Help for details” appears on the display screen, 

press the <HELP> button to display a remedy. Help is not available 

when this message is not displayed.

××××

××××

Error Code

Message on the display screen

Remedy

Scroll display upward

Scroll display downward

<ATTENTION> indicator

××××

Please see HELP for details.

<HELP> button
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●● When Paper Jams Occurs/When an Error 
Message does not Disappear Even After Jammed 
Paper is Removed

When paper is jammed inside a printer or when an error message does not disappear even after 
jammed paper is removed, an error message appears on the display screen.

Press the <HELP> button to display a remedy. Remove jammed paper according to the remedy 
displayed or the relevant procedure described in the following list.

Display Screen when the <HELP> button is pressed

××××

Scroll display upward

Scroll display downward

Press the <HELP> button to display a remedy.

Message on the display screen (first line)
Message on the display screen (second line)

××××

××××

Please see HELP for details.

<ATTENTION> indicator

<HELP> button

Error Code

Status Message on the Display Screen

Message displayed 
after the <HELP>  
button is pressed

Reference 
Page

Error Code
Paper jams 1st Line Open Cassette 391, 392, 393, 394 page 82

2nd Line Paper Jam
3rd Line %TRAY%
1st Line Open Cover 372 page 75
2nd Line Paper Jam
3rd Line Front Cover
1st Line Open Cover 380 page 76
2nd Line Paper Jam
3rd Line Front Cover
1st Line Open Cover 390 page 81
2nd Line Paper Jam
3rd Line Front Cover
1st Line Open Cover 381, 385 page 77
2nd Line Paper Jam
3rd Line Output Tray
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Status Message on the Display Screen

Message displayed 
after the <HELP>  
button is pressed

Reference 
Page

Error Code
Paper jams 1st Line Open Cover 382, 383 page 78

2nd Line Paper Jam
3rd Line Output Tray
1st Line Check Duplex Unit 370, 371, 373 page 74
2nd Line Paper Jam
1st Line Check Paper 400 page 76
2nd Line Paper Size Error
3rd Line %TRAY%
1st Line Check Paper 401 page 76
2nd Line Paper Multi Feed
3rd Line %TRAY%

When a jam occurs, the 
media being printed 
remains in the device.

1st Line Open Cassette 631, 632, 633, 634 page 82
2nd Line Paper Remain
3rd Line %TRAY%
1st Line Open Cover 637 page 81
2nd Line Paper Remain
3rd Line Front Cover
1st Line Open Cover 638 page 77
2nd Line Paper Remain
3rd Line Output Tray
1st Line Open Cover 639, 640 page 78
2nd Line Paper Remain
3rd Line Output Tray
1st Line Check Duplex Unit 641, 642 page 74
2nd Line Paper Remain

Error Code 370, 371, 373, 641, 642

A paper jam has occurred around the duplex 
unit.

1	 Take out the duplex unit (1) by pulling 
it obliquely upward while holding the 
center recess on the back of printer.

1

2	 Check for jammed paper inside the 
printer. If jammed paper remains, 
remove it.
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3	 Check for jammed paper in the duplex 
unit. If jammed paper remains, pull it 
out gently.

4	 Open the upper duplex unit cover (2) 
and check for jammed paper. If jammed 
paper remains, pull it out gently and 
close the cover.

2

5	 Replace the duplex unit (1) into the 
printer.

1

Task is complete.

Error Code 372

A paper jam has occurred around the front 
cover.

1	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

2	 Remove the jammed paper gently in 
the direction of the arrow if an edge of 
jammed paper can be seen, and then 
go to step 8. If you cannot find jammed 
paper, go to step 3.

3	 Take out the duplex unit (3) by pulling 
it obliquely upward while holding the 
center recess on the back of printer.

3
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4	 Check for jammed paper inside a printer. 
If jammed paper remains, remove it.

5	 Check if paper remains in the duplex 
unit. If jammed paper remains, pull it 
out gently.

6	 Open the upper duplex unit cover (4) 
and check for jammed paper. If jammed 
paper remains, remove it, and close the 
cover.

4

7	 Replace the duplex unit (3) to the 
printer.

3

8	 Close the front cover (2).

2

Error Code 380, 400, 401, 637

A paper jam has occurred around the front cover.

1	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

2	 Remove the jammed paper gently in the 
direction of the arrow if you can see an 
edge of jammed paper.
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3	 Close the front cover (2).

2

Task is complete.

Error Code 381, 385, 638

A paper jam has occurred under an image drum.

1	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

2	 Press the output tray open button (3) 
and open the output tray (4).

CAUTION Possible to get 
burned.

●● The fuser unit is extremely hot. Do not touch 
it.

3
4

3	 Remove all four image drums and place 
them on a flat surface.

4	 Cover the removed image drums with 
paper so that the image drums are not 
exposed to light.

5	 Pull out the jammed paper gently to the 
rear of the printer (the direction of the 
arrow) if an edge of jammed paper can 
be seen.

Pull out the jammed paper gently while 
lifting the release levers (5) on the fuser 
unit if an edge of jammed paper cannot 
be seen. 
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If an edge of jammed paper still remains inside 
the unit, pull out the jammed paper gently to the 
rear of the printer.

5

Note

●● In case of Error 385, take out the fuser unit and 
remove the paper from it completely.

6	 Return all four image drums into the 
printer carefully.

7	 Close the output tray (4) by pushing the 
both sides of the cover firmly.

4

8	 Close the front cover (2).
Note

●● The front cover cannot be closed if the output tray is 
not closed securely.

2

Task is complete.

Error Code 382, 383, 639, 640

A paper jam has occurred around the fuser unit.

1	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2
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2	 Press the output tray open button (3) 
and open the output tray (4).

CAUTION Possible to get 
burned.

●● The fuser unit is extremely hot. Do not touch 
it.

3
4

3	 Remove all four image drums and place 
them on a flat surface.

4	 Cover the removed image drums with 
paper so that the image drums are not 
exposed to light.

5	 Remove the jammed paper remaining 
inside of the unit.

6	 Lift the left lock lever (5) of the fuser 
unit forward.

5

7	 Hold the fuser unit handle (6) and lift 
the fuser unit out of the printer.

6
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8	 Lift the release levers (7) on the fuser 
unit, and pull out the jammed paper 
forward gently.

7

9	 Hold the fuser unit handle (6) and place 
the fuser unit into the printer.

6

10	 Push the left lock lever (5) of the fuser 
unit backward.

5

11	 Return all four image drums into the 
printer carefully.

12	 Close the output tray (4) by pushing the 
both sides of the cover firmly.

4

13	 Close the front cover (2).
Note

●● Cannot close the front cover securely if the output 
tray is not closed.

2

Task is complete.
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Error Code 390, 637

A paper jam has occurred while feeding paper 
from a paper tray.

1	 If there is any paper on the MP tray, lift 
the paper set cover (1) and take it out.

1

2	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (2) to open the 
front cover (3) forward.

2

3

3	 Remove the jammed paper gently by 
pulling the edge of paper.

Remove the paper from the back gently 
if the edge of paper cannot be seen.

4	 Close the front cover (3).

3

5	 If loading paper on MP tray, lift the 
paper set cover (1) and set the paper 
with the print side face up.

1

6	 Lower the paper set cover (1).

1

Task is complete.
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Error Code 391, 392, 393, 394, 631, 
632, 633, 634

A paper jam has occurred while feeding paper 
from a paper tray.

Note

●● If paper jams occur frequently, clean the paper feed 
rollers. For details, refer to “Cleaning Paper Feed Rollers” 
P.116.

This procedure uses Tray 1 as an example.

1	 Gently pull out from the printer the tray 
(1) for which an error is indicated. 

1

2	 Remove the jammed paper.

3	 Return the tray (1) to the printer.

1

4	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (2) to open the 
front cover (3) forward.

2

3

5	 Close the front cover (3).

3

Task is complete.

Memo

●● Open and close the front cover after removing the 
jammed paper otherwise the error indication do not 
go out.
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●● When the Message for Replacement of 
Consumables or Maintenance Unit Appears

When the time to replace consumables or maintenance unit is close and replacement must be done, 
the message “…Low”, “…Near Life”, “…Empty”, “…Life”, “Install…”, “Replace…”, “Change…” 
appears on the display screen and the <ATTENTION> indicator on the operator panel lights up or blinks.

Check the message and replace consumables and maintenance unit.

Display Screen when the <HELP> button is pressed

××××

××××

Scroll display upwards

Scroll display downwards

Press the <HELP> button to display a remedy. 

Message on the display screen (first line)

Message on the display screen (third line)

Message on the display screen (fourth line)

××××

××××

××××

××××

Please see HELP for details.

<ATTENTION> indicator

<HELP> button

Message on the display screen (second line)

Error Code
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Memo

●● “xxx” described on the list below changes according to the printer status.

Status Message on the Display Screen

Message displayed 
after the <HELP> 
button is pressed

Reference Page or 
Remedy

Error Code
Toner Cartridge 1st Line xxx - Prepare a new toner 

cartridge, and replace the 
old toner cartridge with new 
one after a message for 
replacement of consumables 
or maintenance unit appears.

2nd Line %COLOR% Toner Low

1st Line xxx - page 104
2nd Line %COLOR% Toner Empty
1st Line Install Toner 410, 411, 412 page 106
2nd Line %COLOR% 413 page 104 (Black toner)

Image Drums 1st Line xxx - Prepare new image drums, 
and replace the old image 
drums with new ones after a 
message for replacement of 
consumables or maintenance 
unit appears.

2nd Line %COLOR% Image Drum Near 
Life

1st Line xxx - page 108
2nd Line %COLOR% Image Drum Life
1st Line xxx - page 108

The number of pages you can 
print is displayed in “nnn”.

2nd Line %COLOR% Image Drum Life, 
%nnn% Pages Left

1st Line Install New Image Drum 350, 351, 352, 353 page 108
If a toner remains, you can 
continue to print by opening 
or closing the front cover. 
However, replace the image 
drum soon. Otherwise, it may 
cause a decrease in a printing 
quality.

2nd Line Image Drum Life
3rd Line %COLOR%

1st Line Install New Image Drum 560, 561, 562, 563 page 108
2nd Line Image Drum Life
3rd Line %COLOR%
1st Line Install New Image Drum 564, 565, 566, 567 page 108
2nd Line Image Drum Life
3rd Line %COLOR%
4th Line To Exceed the Life, Press 

Online Button

1st Line Install New Image Drum 680, 681, 682, 683 page 108
2nd Line Printing disabled due to low 

threshold of Image Drum life.
3rd Line %COLOR%
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Status Message on the Display Screen

Message displayed 
after the <HELP> 
button is pressed

Reference Page or 
Remedy

Error Code
Fuser Unit 1st Line xxx - Prepare a fuser unit, and 

replace the old fuser unit with 
new one after a message for 
replacement of consumables 
or maintenance unit appears.

2nd Line Fuser Unit Near Life

1st Line xxx - page 114
2nd Line Change Fuser Unit
1st Line Install New Fuser Unit 354 page 114

You can continue to print by 
opening or closing the front 
cover for a while. However 
replace the fuser unit soon. 
Otherwise, it may cause a 
printer error or paper jam.

2nd Line Fuser Unit Life

Belt Unit 1st Line xxx - Prepare a belt unit, and 
replace the old belt unit with 
new one after a message for 
replacement of consumables 
or maintenance unit appears.

2nd Line Belt Unit Near Life

1st Line xxx - page 111
2nd Line Change Belt Unit
1st Line Install New Belt Unit 355 page 111

You can continue to print by 
opening or closing the front 
cover for a while. However 
replace the belt unit soon. 
Otherwise, it may cause a 
printer error.

2nd Line Belt Unit Life
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●● When the Message for Paper Replacement or 
Paper Size Error Appears

When the media type or media size loaded in a tray does not match the settings specified in the printer 
driver, the message “Change Paper...” or “Check Paper...” appears on the display screen and the 
<ATTENTION> indicator blinks.

Check the message and deal with the problem. Check the paper size and the settings, refer to “How to 
Print from the Tray” P.53 or “How to Print from the MP Tray” P.54.

Display Screen when the <HELP> button is pressed

××××

××××

Scroll display upward

Scroll display downward

Press the <HELP> button to display a remedy. 

Message on the display screen (first line)

Message on the display screen (third line)

Message on the display screen (fourth line)

××××

××××

××××

××××

Please see HELP for details.

<ATTENTION> indicator

<HELP> button

Message on the display screen (second line)

Error Code

Status Message on the Display Screen

Message 
displayed after 

the <HELP> 
button is 
pressed

Error Code
Change Paper 1st Line Change Paper in %TRAY% 661, 662, 663, 664

2nd Line %MEDIA_SIZE%
3rd Line %MEDIA_TYPE%
4th Line Press ONLINE Button
1st Line Change Paper in MPTray 660
2nd Line %MEDIA_SIZE%
3rd Line %MEDIA_TYPE%
4th Line Press ONLINE Button

Paper Size does not match print data. 1st Line Change Paper in %TRAY% 461, 462, 463, 464
2nd Line %MEDIA_SIZE%
3rd Line %MEDIA_TYPE%
4th Line Press ONLINE Button
1st Line Change Paper in MPTray 460
2nd Line %MEDIA_SIZE%
3rd Line %MEDIA_TYPE%
4th Line Press ONLINE Button
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●● Other Error Messages
This section explains the causes and remedies for an error message and the function of the 
<ATTENTION> indicator. An error message appears on the display screen of the operator panel. 

To display an error code, press the <HELP> button on the operator panel.

Error Messages

Error 
code Message <ATTENTION> 

indicator Cause/Remedy

420 Press ONLINE Button for Restoration
Memory Overflow

Blinks The memory overflowed.
Reduce the data amount. If that does not 
work, reduce the size of the print data.

310
311

%COVER% Open

Please see HELP for details

Blinks The cover is open.
Close the cover.
310 : Output tray
311 : Front cover

320
348

Check Fuser Unit

Please see HELP for details

Blinks The fuser unit is not correctly installed.
Install the fuser unit correctly in a printer.

Check Data
Message Data Write Error<%CODE%>

Lights up Writing of message data to be uploaded to a 
printer has been failed.

610
611
612
613

Toner Not Installed
%COLOR%

Please see HELP for details

Blinks The toner cartridge of the indicated color 
is not installed correctly. Install the toner 
cartridge correctly.
610 : Yellow (Y)
611 : Magenta (M)
612 : Cyan (C)
613 : Black (K)

544
545
546
547

Check Toner Cartridge
Improper Lock Lever Position
%COLOR%

Please see HELP for details

Blinks The toner cartridge of the indicated color is 
not locked properly.
Turn the blue lever on the right side of the 
cartridge backwards until it stops.
544 : Yellow (Y)
545 : Magenta (M)
546 : Cyan (C)
547 : Black (K)

540
541
542
543

Toner Sensor Error
%COLOR%

Please see HELP for details

Blinks Something is wrong with the toner sensor of 
the indicated color or the image drum is not 
installed correctly.
Install the toner cartridge or image drum of 
the indicated color correctly.
540 : Yellow (Y)
541 : Magenta (M)
542 : Cyan (C)
543 : Black (K)

430
431
432
433
440
441
442

Install Paper Cassette
%TRAY%

Please see HELP for details

Blinks A paper cassette is not in the indicated tray.
Insert the paper cassette into the indicated 
tray.
If the cassette is already inserted in the 
printer, pull out the cassette and set it again 
to correctly locate it.
430, 440 : Tray1
431, 441 : Tray2
432, 442 : Tray3
433 : Tray4
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Error 
code Message <ATTENTION> 

indicator Cause/Remedy

356 Install New Belt Unit
Belt Unit Life

Please see HELP for details

Blinks The belt unit is at the end of its life.
Replace it with a new belt unit.

File System is Full Lights up The file system is full.
File System is Write Protected Lights up The file system to which you tried to write is 

write-protected.
330 Check Belt Unit

Please see HELP for details

Blinks The belt unit is not properly installed.
Reinstall it properly.

Deleting data Lights up The print data of private jobs are being 
deleted.

Print Restricted. Job Rejected

Press ONLINE Button

Lights up A print job sent by a user who is not 
authorized for printing is deleted. 

Color Restricted. Job Rejected

Press ONLINE Button

Lights up A color print job sent by a user who is not 
authorized for color printing is deleted.

Color Restricted. Mono Printed

Press ONLINE Button

Lights up A color print job sent by a user who is not 
authorized for color printing is printed in the 
mono-print mode.

Erased Data Full Lights up Secret file to be erased are full.
491
492
493
494
490

Install Paper
%TRAY%
%MEDIA_SIZE%

Please see HELP for details

Blinks The indicated tray is empty.
Load the indicated size paper.
491 : Tray1
492 : Tray2
493 : Tray3
494 : Tray4
490 : MPTray

File Erasing Lights up Erasing a secret file.
Error Postscript Goes off A postscript error has occurred.

694
695
696
697

Image Drum Not Installed
%COLOR%

Please see HELP for details

Blinks The image drum of the indicated color is not 
installed correctly. Install the image drum 
correctly.
694 : Yellow (Y)
695 : Magenta (M)
696 : Cyan (C)
697 : Black (K)

340
341
342
343

Check Image Drum
%COLOR%

Please see HELP for details

Blinks The image drum of the indicated color is not 
installed correctly. Install the image drum 
correctly.
340 : Yellow (Y)
341 : Magenta (M)
342 : Cyan (C)
343 : Black (K)

Wait a Moment
Rebooting <n>

Lights up The printer is restarting.
Please wait.

%COLOR% Toner Sensor Error Lights up Something is wrong with the toner sensor of 
the indicated color or the image drum is not 
installed correctly.
Install the toner cartridge or image drum of 
the indicated color correctly.

%COLOR% Toner Not Installed Lights up The toner cartridge of the indicated color 
is not installed correctly. Install the toner 
cartridge correctly.

%TRAY% Empty Lights up The indicated tray is empty.
Load the paper.
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Error 
code Message <ATTENTION> 

indicator Cause/Remedy

Unsupported USB Device Detected

Please detach it

Goes off A USB device unsupported by a printer is 
connected. Remove the device.

Install Paper
MPTray
%MEDIA_SIZE%
Press ONLINE Button

Goes off Manual Printing from the MP tray is 
specified. Load the paper of the size 
indicated in the MP tray, and then press the 
<ON LINE> button.

%COLOR% Waste Toner Full.Replace Toner. Lights up Waste toner is full. Replace with a new toner 
cartridge of the indicated color.

Collate Fail:Too Many Pages

Press ONLINE Button

Goes off A collate print error has occurred.
Reduce the data amount. If that does not 
work, reduce the size of the print data.

File System Operation failed<nnn>

Press ONLINE Button

Lights up A file access error has occurred.

Power Off and Wait for a while
126:Condensing Error

Blinks A condensation has occurred inside a printer. 
Turn the printer off and turn on again after 
a while.

Invalid Print Data Received

Press ONLINE Button

Lights up A job is deleted because its data are 
detected to have been corrupted when 
private jobs are printed.

USB Hub Unsupported

Please detach it

Goes off A USB hub unsupported by a printer is 
connected. Remove the hub.

Log Buffer is Full. Job Rejected

Press ONLINE Button

Lights up Print data is deleted because the accounting 
log buffer is full. Contact a printer 
administrator and remove the log buffer.

360 Install Duplex Unit

Please see HELP for details

Blinks A duplex unit is not installed correctly. 
Install a duplex unit in a printer correctly. 
When a duplex unit is already installed, pull 
out the unit, and then install it again.

nnn* Service Call
nnn: Error

Blinks An error occurred inside the printer. Turn the 
printer off and then on again.
Write down the error code and contact your 
dealer if the same error occurs again.

nnn* Power Off/On
nnn:Error

Blinks A fatal error has occurred in a printer. 
Turn the power off/on. Contact your dealer if 
the same error occurs again.

PDL Error Occurred Varies Indicating that it has been occured an 
internal processing error into the PDL 
emulation.
It's a clearable warning. User should press 
ENTER button for clearing the warning.

Expired saved files have been deleted

Press ONLINE Button

Lights up Indicates that an applicable job has been 
automatically deleted as the retention period 
for Private Job Print has expired.

Decode error occurred

Press ONLINE Button

Varies Indicates that an error has occurred during 
analysis of image data input from an 
external source.
This appears when an error has occurred 
during analysis of TIFF or JPEG data in 
USBMemoryPrint, DirectPrint, E-mailPrint 
mode.

Can not read the file

Press ONLINE Button

Varies Indicates that the USB memory is 
disconnected while PrintFromUSBMemory 
is running. Reading of the image file is 
cancelled.
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Error 
code Message <ATTENTION> 

indicator Cause/Remedy

Color toner empty. Job cancelled

Press ONLINE Button

Varies Notifies the user that the color toner is 
empty and that the received color data job 
is cancelled.

Duplex Print Failed

Press ONLINE Button

Lights up For the paper setting that a duplex printing 
is not possible, it was printed in simplex.

E-mail receiving has been cancelled

Press ONLINE Button

Lights up Indicates that Email receiving has been 
canceled.
It has the following possibilities.
- �The format of email that has received is 

illegal or not supported.
- �The attached file is illegal or not 

supported.
- �The attached file that has received is too 

large, for example, file size exceeds 8MB.
- Network connection has disconnected.

Invalid Data

Press ONLINE Button

Varies Invalid data was received. Press the On-line 
switch and eliminate the warning. Displayed 
when unsupported PDL command is received 
or a spool command is received without SD 
Card.

Error PDF

Press ONLINE Button

Varies It appears when a PDF file contains a syntax 
error.

Invalid Password

Press ONLINE Button

Varies Notifies that the entered password does not 
match the password set to encrypted PDF.
The file will not be printed unless the 
passwords match.

PDF Cache Write Error

Press ONLINE Button

Varies Notifies that writing a PDF file to the cache 
has failed.
When an SD card is not used, add memory 
or an SD card.
When an SD card is used, increase free 
space on the SD card.

Job Type restricted
Job rejected
Press ONLINE Button

Varies A job of a JobLimitation setting violation is 
received, and when discarding the job, it's 
indicated.

Please change SD Memory Card Lights up Indicates that machine requests a user to 
exchange old SD card device for new one 
because the SD card device is life.

415
416

Replace Toner
%COLOR% Waste Toner Full

Please see HELP for details

Blinks Indicates that a waste toner box represented 
by %COLOR% has become full and needs to 
be replaced. 

Error 415 : Magenta
Error 416 : Cyan
(Does not occur for Black/Yellow.)

480 Remove Paper
Output Tray

Please see HELP for details 

Blinks The printed paper is overfilled on the paper 
stacker of the printer unit.
Error 480 : Output Tray

519 Press ONLINE Button for Restoration
Receiving Data Timeout

Please see HELP for details

Blinks When receiving data by Port9100, LPR, FTP, 
IPP, WSD, or Email, a timeout occurred in 
stream.

IPv4 Address is conflicted
Change IPv4 Address

Varies IPv4 address is conflicted.

Getting target IP failed. 
Please check DHCP settings.

Varies Indicates that DHCP server is not found out.
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Error 
code Message <ATTENTION> 

indicator Cause/Remedy

Wait a Moment
Network Initializing

Varies This appears when the NIC initialization is 
occurred, as the setting was changed.

Wait a moment
Network Configuration writing

Blinks This appears during the NIC configuration 
data is storing into the flash memory, as the 
setting was changed.

709 Caution, unknown Consumable detected 
Go to User Manual “Trouble Shooting” to 
restore operation

Blinks You can use any consumables in your 
product, but you must accept the risks of 
using non-genuine consumables.  If the use 
of non-genuine consumables causes damage 
to the product or results in your product 
not functioning to its full specification, then 
such damage or effect on the product is not 
covered by warranty. To accept these risks 
and to restore function;
 1. Turn off your product
 2. Press and hold the <CANCEL> button 
and turn your product on
 3. After start up, release the <CANCEL> 
button
Note

This operation will be recorded for future 
reference. 
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●● When You Cannot Print from the MP Tray
If you print from the MP tray without moving down the paper set cover, the message “Install Paper 
MPTray” appears on the display screen.

Check the message and deal with the problem. Refer to ”How to Print from the MP Tray” P.54.

Paper set cover
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●● Other Issues
This section explains the issues you may encounter while operating your printer and how to solve them.

Unable to Print from a Computer

Memo

●● If the following information does not solve the issue, contact your dealer.

●● For issues caused by an application, contact the manufacturer of the application.

General Causes

�� Common to Windows and Mac OS X
Cause Remedy Reference

The printer is turned off. Turn on the printer. page 21
An Ethernet or USB cable is unplugged. Check that the cable is plugged into the printer and 

computer properly.
-

Something is wrong with a cable. Replace it with a new cable. -
The printer is off line. Press the <ON LINE> button. -

An error message is displayed on the 
display screen of the operator panel.

“Error Messages” or press the <HELP> button on the 
operator panel.

page 87

The interface setting is disabled. Check the setting of the interface being used from the 
operator panel.

Advanced

Something is wrong with the print 
function.

Check if you can print the contents of the settings. page 30

�� For Windows
Cause Remedy Reference

The printer is not set as the default 
printer.

Set the printer as the default printer. -

The output port for the printer driver is 
incorrect.

Select the output port to which the Ethernet or USB 
cable is connected.

-

A print job from another interface is in 
progress.

Wait until the print job is done. -

“Invalid data” is displayed on the display 
screen and printing cannot be done.

Press the scroll button  or  and select [Menus] > 
[System Adjust] > [Timeout InJob], and then select 
a longer time. The default setting is 40 seconds.

-

A print job is automatically canceled. If using Print Job Control, the print job is not authorized 
to print.

Advanced
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Network Connection Problems

�� Common to Windows and Mac OS X
Cause Remedy Reference

Using a crossover cable. Use a straight cable. -
The printer is turned on before a cable 
was connected.

Connect cables before turning on the printer. page 32

The hub and the printer are incompatible 
or have some problem.

Press the scroll button  or  and select [Admin Setup] > 
[Network Setup] > [HUB Link Setting], and then select 
[10Base-T Half].

-

Not connected to the wireless LAN access 
point.

●● When the device is connected to the wireless LAN 
(Infrastructure mode), disable the wireless LAN (AP 
mode).

●● Check that the power switch of the wireless LAN 
access point is turned on.

●● Check settings of the wireless LAN access point, and 
then perform manual setting or automatic setting.

●● Restart the wireless LAN function.
●● Select [Wireless Reconnection] from [Wireless 
(Infrastructure) Setting].

●● Put the device in an unobstructed view position near 
the wireless LAN access point. (The recommended 
distance is 30 m or less)

●● If there is a wall, a metal item or a radio wave 
generating device between this device and the 
wireless LAN access point, communication failure may 
occur.

-

�� For Windows
Cause Remedy Reference

IP address is incorrect. ●● Check that the same IP address is set for the printer 
and the printer's port setting on the computer.

●● If using LPR Utility, check the IP address setting in 
LPR Utility.

-

USB Connection Problems

�� Common to Windows and Mac OS X
Cause Remedy Reference

Unsupported USB cable is being used. Use a USB 2.0 cable. -
A USB hub is being used. Connect the printer directly to the computer. page 42
Printer driver is not installed correctly. Reinstall printer driver. page 43, 

page 44

�� For Windows
Cause Remedy Reference

The printer is off line. Right-click the [OKI C833 *] icon on the [Devices and 
Printers] folder, and then select [See print jobs] (If 
the icons are grouped, select [See print jobs] > [OKI 
C833 *]).
*	Indicates the driver type. (ex. PCL6/PS/XPS)

In the dialog box, select the [Printer] menu and then 
clear the check of [Use Printer Offline].

-

A switch, buffer, extension cable or USB 
hub is being used.

Connect the printer directly to the computer. page 42

A driver for a different printer that uses a 
USB connection has been installed.

Delete the other printer driver from the computer. -
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Unable to Install a Printer Driver Successfully

Memo

●● If the following information does not solve the issue, contact your dealer.

●● For issues caused by an application, contact the manufacturer of the application.

USB Connection Problems

�� For Windows
Cause Remedy Reference

An icon of the printer is not created on 
the [Devices and Printers] folder.

The printer driver is not installed correctly.
Reinstall the printer driver correctly.

page 43

Only the first printer driver is installed 
even if multiple printer drivers are 
selected to install.

Follow the procedure below to install the second and 
subsequent printer drivers:
1. Insert the “Software DVD-ROM” into a computer.
2. When [AutoPlay] is displayed, click [Run Setup.exe].

Memo

●● If the [User Account Control] dialog box is displayed, 
click [Yes].

3. Select a language from the drop-down list.
4. Read the license agreement, and then click [Accept].
5. �Read Environmental advice for Users and click 

[Next].
6. �Select [Network] or [USB] corresponding to your 

connection environment, and then click [Next]. 
If the [Windows Security Alert] dialog box is 
displayed, click [Allow access].

7. �Select the model name of this machine, and then 
click [Next].

8. Click [Custom Install].
9. Click [Separate Install].
10. �Click a driver to install.
Installation starts.

-

The “Unable to install printer driver” 
error message is displayed.

Use Plug-and-Play. Follow the procedure below.
1. �Ensure that the printer and computer is turned off.
2. �Connect a USB cable.
3. �Turn on the printer.
4. �Turn on the computer.
5. �When the Found New Hardware Wizard is displayed, 

follow the on-screen instructions to complete the 
setup.

-
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OS-Specific Constraints 

Constraints with Windows

Item Symptom Cause/Remedy
Printer drivers [Help] is not displayed. The [Help] function is not supported on PS printer drivers.

The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account 
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start.

Color Correct 
Utility

The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account 
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start.

The [Program Capability 
Assistant] dialog appears.

If the [Program Capability Assistant] dialog appears 
after an installation (including if you stop an installation 
before it is completed), make sure to click [This program 
installed correctly].

PS Gamma 
Adjuster

The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account 
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start.

The [Program Capability 
Assistant] dialog appears.

If the [Program Capability Assistant] dialog appears 
after an installation (including if you stop an installation 
before it is completed), make sure to click [This program 
installed correctly].
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Image Quality Issues

Memo

●● If the following information does not solve your issues, contact your dealer.

Symptom Point to check Remedy Reference
Vertical lines appear.

Paper feed direction

The toner is low. Replace the toner cartridge. page 104
The image drum is damaged. Replace the image drum. page 108
Foreign materials may be present 
on the image drum.

Replace the image drum. page 108

The light-shielding film of the 
image drum is dirty.

Wipe the film with a soft tissue 
paper.

-

The image drum is not installed 
properly.

Install the image drum properly. page 108

Printed images are 
fading vertically.

Paper feed direction

The LED heads are dirty. Wipe the LED heads with soft 
tissue paper.

page 118

The toner is low. Replace the toner cartridge. page 104
The paper is unsuitable. Use supported paper. page 48

Printed images are light. The toner save is enabled. Change the toner save settings. -
The toner cartridge is not installed 
properly.

Install the toner cartridge properly. page 104

The toner is low. Replace the toner cartridge. page 104
The paper is moist. Use paper stored in proper 

temperature and humidity 
conditions.

page 48

The paper is unsuitable. Use supported paper. page 48
The paper is unsuitable.
The settings of media type and 
weight are incorrect.

Press the scroll button  or  
and select [Menus] > [Tray 
Configuration] > the paper tray 
configuration you are using, and 
then select the proper values 
for [Media Type] and [Media 
Weight]. Or, select a larger value 
for [Media Weight].

page 48

The paper is recycled. 
The media weight setting is 
unsuitable.

Press the scroll button  or  
and select [Menus] > [Tray 
Configuration] > the paper tray 
you are using, and then select a 
larger value for [Media Weight].

page 48

Printed images are 
partially faded. Spots 
and lines appear.

The paper is too moist or dry. Use paper stored in proper 
temperature and humidity 
conditions.

page 48

[Paper Black Setting] or [Paper 
Color Setting] is improperly 
configured.

Press the scroll button  or , 
select [Menus] > [Print Adjust], 
and then change the value of 
[Paper Black Setting] or [Paper 
Color Setting].

-

[Trans. Black Setting] or [Trans. 
Color Setting] is improperly 
configured.

Press the scroll button  or , 
select [Menus] > [Print Adjust], 
and then change the value of 
[Trans. Black Setting] or [Trans. 
Color Setting]. 

-
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Symptom Point to check Remedy Reference
Horizontal lines 
and spots appear 
periodically.

Paper feed direction

If the interval of lines or spots 
is about 94 mm (4 inches), the 
image drum (the green tube) is 
damaged or dirty.

Lightly wipe the image drum with 
soft tissue paper.
Replace the image drum if it is 
damaged.

page 108

If the interval of lines or spots is 
about 40 mm (2 inches), foreign 
materials may be present on the 
image drum.

Open and close the output tray, 
and print again.

-

If the interval of lines or spots is 
about 143 mm, there is damage to 
the fuser unit.

Change the fuser unit. page 114

The image drum has been exposed 
to light.

Place the image drum back into 
the printer and leave it for a few 
hours. If that does not solve the 
problem, replace the image drum.

page 108

The paper feed path is dirty. Print a few test copies. -
White area of paper is 
lightly stained.

The paper contains static 
electricity.

Use paper stored in proper 
temperature and humidity 
conditions.

page 48

The paper is too thick. Use thinner paper. -
The toner is low. Replace the toner cartridge. page 104

Periphery of letters is 
smudged.

The LED heads are dirty. Wipe the LED heads with soft 
tissue paper.

page 118

The paper is unsuitable. Use recommended paper. -
The paper is moist. Replace it with new paper. page 48

The entire paper area 
is lightly stained when 
printing on envelopes or 
coated paper.

The toner may be sticking to the 
whole area of the envelope or 
coated paper.

This is not a malfunction of the 
printer.
Coated paper is not recommended.

-

Toner comes off when it 
is rubbed.

The settings of media type and 
weight are incorrect.

Press the scroll button  or  
and select [Menus] > [Tray 
Configuration] > the paper 
tray configuration you are using, 
and then select the proper 
values for [Media Type] and 
[Media Weight]. Or, select a 
heavier weight in [Media Weight].

page 48

The paper is recycled.
The media weight setting is 
unsuitable.

Press the scroll button  or  
and select [Menus] > [Tray 
Configuration] > the paper tray 
configuration you are using, and 
then select a heavier weight for 
[Media Weight].

page 48

Glossiness is not 
uniform.

The settings of media type and 
weight are incorrect.

Press the scroll button  or  
and select [Menus] > [Tray 
Configuration] > the paper 
tray configuration you are using, 
and then select the proper 
values for [Media Type] and 
[Media Weight]. Or, select a 
heavier weight in [Media Weight].

page 48
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Symptom Point to check Remedy Reference
Color of the printed 
image is not what you 
expect.

The toner is low. Replace the toner cartridge. page 104
The setting of [Black Finish] is 
not suitable for the application.

On the printer driver, select 
[Composite Black (CMYK)] 
or [True Black (K)] for [Black 
Finish].

Advanced

The color adjustment has been 
modified.

Do color matching from the printer 
driver.

Advanced

The color balance is out of 
adjustment.

Press the scroll button  or  and 
select [Calibration], and then 
[Adjust Density].

Advanced

Color registration is out of 
alignment.

Open and close the output tray.
Or, press the scroll button  or  
and select [Calibration], and then 
[Adjust Registration].

Advanced

Solid printing of CMY 
100% is too light.

[CMY100% Density] is set to 
[Disable].

Press the scroll button  or  and 
select [Admin Setup] > [Color 
Setup] > [CMY100% Density], 
and then select [Enable].

-

Dots appear. The paper is unsuitable. Use supported paper. page 48
When the interval of the dots 
is about 94 mm (4 inches), the 
image drum (the green tube) is 
damaged or dirty.

Lightly wipe the image drum with a 
soft tissue paper.
Replace the image drum when it is 
damaged.

page 108

Smears is printed. The paper is moist. Replace it with new paper. page 48
The paper is unsuitable. Use supported paper. page 48

The background of a 
printed page is dark or 
dirty.

The printer may be malfunctioning. Contact your dealer. Back cover

Nothing is printed.

?
Two or more sheets of paper are 
fed simultaneously.

Fan the paper well and load it 
again.

page 53, 
page 54

The printer may be malfunctioning. Contact your dealer. -

Patches appear. The paper is moist. Replace it with new paper. page 48
The paper is unsuitable. Use supported paper. page 48
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Feeding Issues

Memo

●● If the following information does not solve the issue, contact your dealer.

Symptom Point to check Remedy Reference
●● The paper often 
jams.

●● Multiple sheets 
are fed at once.

●● The paper is fed 
at an angle.

The printer is tilted. Place the printer on a flat surface. page 16
The paper is too light or too heavy. Use the appropriate paper for the 

printer.
page 48

The paper is moist or has a static 
charge.

Use paper stored in proper 
temperature and humidity 
conditions.

page 48

The paper is wrinkled, folded or 
curled.

Use appropriate paper for the printer. 
Fix the curled paper.

page 48

Something is already printed on the 
back side of the paper.

With tray 1/2/3/4, you cannot use 
paper that has been printed.
Load it on the MP tray for printing.

page 54

The edges of the paper are not kept 
even.

Fan the paper and even up the 
edges.

page 53, 
page 54

There is only one sheet of paper in 
the tray.

Load several sheets of paper. page 53, 
page 54

You have added more paper with 
paper already loaded in the tray.

Remove the already loaded paper, 
stack it onto the new paper, even up 
the edges and load the paper with 
the old paper on top.

page 53, 
page 54

The paper is loaded at an angle. For tray 1/2/3/4, adjust the paper 
width guide and stopper to the 
paper.
For the MP tray, adjust the paper 
width guide to the paper.

page 53, 
page 54

Envelopes are not correctly loaded. Load envelopes correctly. page 54
Paper, envelopes or labels of weight 
between 177 and 220 g/m2 is loaded 
in tray 1 and tray 2.

Load the paper, envelopes or labels 
of weight between 177 and 220 g/m2 
on the MP tray, and use the face up 
stacker.

page 48, 
page 54

Paper does not feed 
into the printer.

The setting of [Source] in the 
printer driver is not correctly 
specified.

Check the paper tray and select 
the correct tray in [Source] in the 
printer driver.

-

You have specified manual feeding 
on the printer driver.

In the printer driver, clear the [Use 
MP tray as manual feed] check 
box on [Paper feed options].

Advanced

The printer does 
not start processing 
even though you 
have removed the 
jammed paper.

- Open and close the output tray. -

The paper gets 
folded or wrinkled.

The paper is moist or has a static 
charge.

Use paper stored in proper 
temperature and humidity 
conditions.

page 48

The paper is light. Press the scroll button  or  and 
then select [Menus] > [Tray 
Configuration] > [%TRAY% 
Config] > [Media Weight].
Then, specify a lighter weight.

page 48
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Symptom Point to check Remedy Reference
The paper twists 
around the rollers 
in the fuser unit.

The settings of media weight and 
type are incorrect.

Press the scroll button  or  and 
then select [Menus] > [Tray 
Configuration] > [%TRAY% 
Config] > [Media Type]/ [Media 
Weight]. Then, specify the 
appropriate values.
Or, specify a heavier weight in 
[Media Weight].

page 48

The paper is light. Use heavier paper. -
There is an image or text on the 
leading edge of the paper.

Add a margin on the leading edge of 
the paper.
For duplex printing, leave a margin 
in the leading and bottom edges.

-

Machine Issues

Symptom Point to check Remedy Reference
You turned on the 
printer, but nothing 
displays on the 
screen.

The AC cord is unplugged. Turn off the printer and then plug in 
the AC cord firmly.

-

The power is out. Check if the power is being supplied 
to the electric outlet.

-

The printer does 
not operate.

The AC cord is not firmly plugged in. Plug in the AC cord firmly. -
The printer is turned off. Turn on the printer. page 21
The printer turned off automatically 
by the auto power off function.

Disable the auto power off function. page 69

Printer does not answer. Hold down the power switch for more 
than 5 seconds to turn off the printer 
forcibly. 

-

The printer does 
not start printing.

An error is displayed on the panel. Check the error code and follow the 
on-screen instructions.

page 87

The Ethernet or USB cable is 
unplugged.

Plug in the Ethernet or USB cable 
firmly.

page 32, 
page 42

Something is wrong with the 
Ethernet or USB cable.

Use another Ethernet or USB cable. -

The printer does not support your 
Ethernet or USB cable.

●● Use a USB 2.0 compatible cable.
●● Use an Ethernet 10BASE-T/ 
100BASE-TX/1000BASE-TX 
compatible cable.

-

Something may be wrong with the 
printing function.

Press the scroll button  or  and 
select [Print Information] > 
[Configuration] and then print the 
contents of the settings to check the 
printing function.

page 30

The interface is disabled. Press the scroll button  or  and 
select [Admin Setup] > [Network 
Setup] and enable the interface you 
are using.

-

The printer driver of the printer is 
not selected.

Set the printer driver of the printer 
as the default printer.

-

The specified port of the printer 
driver is wrong.

Specify the port the Ethernet or USB 
cable is connected to.

-

The display screen 
is blank.

The printer is in the deep sleep 
mode. 

Check if the <POWER SAVE> 
button lights up and press the 
<POWER SAVE> button to activate 
the printer.

page 22

Print data is not 
transmitted to the 
printer.

The Ethernet or USB cable is broken. Connect a new cable. -
The time-out period set on the 
computer has passed.

Set a longer time-out period. -
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Symptom Point to check Remedy Reference
There is an 
abnormal sound.

The printer is tilted. Place the printer on a flat surface. -
There is a piece of paper or foreign 
object inside the printer.

Check the inside of the printer and 
remove any objects.

-

The output tray is open. Close the output tray. -
There is a buzzing 
sound.

The printer is printing on the heavy 
or thin paper when the temperature 
inside is high.

This is not a malfunction. You can 
proceed with the operation.

-

It takes a while to 
start printing.

The printer may be cleaning the 
image drum.

Wait for a while. -

The printer is adjusting the 
temperature of the fuser unit.

Wait for a while. -

The printer is processing data from 
another interface.

Wait until the process finishes. -

A print job has 
stopped in the 
middle of the 
printing process.

As a result of processing print jobs 
continuously for a long time, the 
inside the printer has become hot. 
The printer is cooling off.

Wait for a while.
When the fuser unit becomes cooler, 
printing restarts automatically.

-

As a result of processing print jobs 
continuously for a long time, the 
temperature in the printer inside 
has become too high. The printer is 
cooling off.

Wait for a while.
When the printer becomes cooler, 
printing restarts automatically.

-

When the print processing is 
overloaded by printing with the WSD 
port, a computer may stop sending.

Retry to send data on a computer. If 
the error is not resolved, use other 
network port.

-

Memory is 
insufficient.

A printer is short on memory 
because print data is too large.

Reduce print data with a printer 
driver.

Advanced

It takes a long time 
to finish printing.

The processing speed of the 
computer may be slowing down the 
print job.

Use a computer with faster 
processing speed.

-

You have selected [Fine / Detail 
(1200x1200)] or [ProQ/High 
Quality] on the [Job Options] tab 
of the printer driver.

Select [Normal (600x600)] on the 
[Job Options] tab of the printer 
driver.

-

The print data is complex. Make the data simpler. -
Paper is narrow (less than 230 mm). Change the mode. Advanced

The printer driver 
is not correctly 
displayed on Mac 
OS X.

The printer driver may not be 
operating correctly.

Uninstall the printer driver and install 
it again.

Advanced

Paper is curled. Thin paper is used. Set an appropriate paper weight or 
select [High Humid Mode].

Advanced

Paper is wet on the 
edge.

Wet paper is used. Select [Moisture Control]. Advanced

The LED indicator
in the power switch
is blinking at high
speed per about
0.3 seconds.

The printer may be malfunctioning.  Unplug the AC cord immediately. -
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4. Maintenance
This chapter explains how to replace consumables and maintenance units, clean the printer, and move 
or transport the printer.

●● Replacing Consumables and Maintenance Units
This section explains how to replace consumable items.

WARNING

Do not throw the toner or 
toner cartridge into the fire. 
Doing so may cause toner 
splashes leading to burns.

Do not keep the toner 
cartridge in places close to 
the fire. It may catch the 
fire, which cause fire and 
burns.

Do not vacuum spilled toner 
powder. If vacuuming, it may 
cause ignition due to the 
sparks from electric contacts. 
Toners spillage on the floor 
should be wiped off by wet 
clothes.

CAUTION

There are high temperature 
parts in the device. Do 
not touch the periphery 
of the label "Caution High 
Temperature", which may 
cause burns.

Keep the toner cartridge out 
of reach of young children. If 
young children swallow toner 
powder, follow the doctor's 
direction immediately.

If toner powder is inhaled, 
gargle with large amounts of 
water and move the person 
to the open area for fresh air. 
Follow the doctor's direction 
if necessary.

If the toner powder sticks to 
your skin like your hands, 
wash with soap.

If the toner gets into the 
eyes, flush with plenty of 
water immediately. Follow 
the doctor's direction if 
necessary.

If you swallow toner powder, 
take large amounts of water 
to weaken the toner. Follow 
the doctor's direction if 
necessary.

When handling a paper 
jam, or replacing the toner 
cartridge, make sure not to 
get your cloth and hands 
dirty. When toner powder 
stains on your cloth, wash 
with cold water. If you wash 
with hot water, the toner 
may be soaked into the 
cloth; it may be difficult to 
clean.

Do not disassemble the toner 
cartridge. Toner powder may 
fly upward, and you may 
inhale the toner powder 
or may get your cloth and 
hands dirty.

Keep a used toner cartridge 
in a bag so that the toner 
powder can not fly upward.

Note

●  Use only genuine OKI consumable items to ensure optimum quality.

●● Service for problems due to use of consumable items other than genuine OKI consumables will incur fees even in the warranty 
period or the maintenance contract period.
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Replacing Toner Cartridges

Note

●● Toner powder may spill if you remove a toner cartridge 
before the toner runs out.

Life Span of Toner Cartridge

When the “%COLOR% Toner Low” message 
(“%COLOR%” indicates C (cyan), M (magenta), 
Y (yellow) or K (black)) appears on the display 
screen, prepare a replacement toner cartridge. 
You can keep printing several hundred pages 
until the next message appears.

The number of pages that can make prints 
depends on the usage.

When the “%COLOR% Toner Empty” appears 
and printing is stopped, replace the toner 
cartridge.

Memo

●● Even if the cyan (blue), magenta (red) or yellow toner 
cartridges run out, you can print in black and white by 
selecting [Monochrome] or [Grayscale]. However, 
please replace the toner cartridge quickly after it runs 
out, as not doing so may cause the image drum to be 
damaged.

Note

●● The actual life of the toner cartridge differs depending on 
the usage.

Note

●● Have a new print cartridge ready, as the print quality 
declines after more than one year following breaking the 
seal.

●● If you replace the toner cartridge/image drum while it is 
being used, the amount of toner used will not be counted 
normally.

●● By opening and closing the output tray after the message 
“Color toner empty.” is displayed, you are able to print 
approximately 100 copies of A4 size ISO test patterns 
(approximately 20 pages, five times). However further 
printing operations will not be possible after that. Please 
replace the toner cartridge as failure to do so may 
damage the image drum.

Procedure for Replacement (for K 
(black) Toner Cartridge)

Memo

●● When replacing the C, M, Y toner cartridges, refer to 
“Procedure for Replacement (for C (cyan), M (magenta), Y 
(yellow) Toner Cartridges)” P.106.

1	 Prepare a new [K] toner cartridge.

2	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

3	 Turn the blue lever (3) of the toner 
cartridge.

3
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4	 Lift the toner cartridge (4) from the right 
side, and remove it from the printer.

WARNING Possible to get 
burned.

●● Do not throw a used toner cartridge in the 
fire. They may explode, and the toner inside 
may fly off and cause getting burned.

Note

●● When toner powder adheres to the paper feeding 
area inside the printer, wipe it off with a wet cloth 
that has been well wrung.

4

5	 Leaving the replacement toner cartridge 
in its bag, gently shake it up and down 
and side to side, and then unpack it.

6	 Remove the tape (5) from the toner 
cartridge.

5

7	 Insert a new toner cartridge (6) by 
aligning its left side indentation (7) with 
the protrusion (8) on the image drum so 
the toner cartridge and image drum [K] 
color label align. Then fix the right side 
firmly into place.
Note

●● Do not insert a toner cartridge without removing the 
tape.

6

8
7

8	 Turn the blue lever (3) of the toner 
cartridge backward until its top aligns on 
the  mark.

3

9	 Close the front cover (2).
Note

●● The front cover cannot be closed if the output tray is 
not closed securely.

2
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10	 Please recycle toner cartridges.
Memo

●● If you must dispose of a toner cartridge, put it in a 
plastic bag or similar container and dispose of it in 
accordance with your municipality’s ordinances or 
guidelines.

Procedure for Replacement (for C 
(cyan), M (magenta), Y (yellow) 
Toner Cartridges)

Memo

●● When replacing the K toner cartridge, refer to “Procedure 
for Replacement (for K (black) Toner Cartridge)” P.104.

1	 Prepare new toner cartridges.

2	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

3	 Press the output tray open button (3) 
and open the output tray (4).

CAUTION Possible to get 
burned.

●● The fuser unit is extremely hot. Do not touch 
it.

3
4
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4	 Identify an empty toner cartridge by its 
label color (5).

5

5	 Slide the right blue lever (6) of the toner 
cartridge while pressing the top of the 
cartridge to unlock.

6

6	 Lift the toner cartridge (7) from right 
side, and remove it from the printer.

WARNING Possible to get 
burned.

●● Do not throw a used toner cartridge in the 
fire. They may explode, and the toner inside 
may fly off and cause getting burned.

7

7	 Unpack the replacement toner cartridge, 
and gently shake it up and down and 
side to side.

8	 Remove the tape (8) from the toner 
cartridge.

8

9	 Insert a new toner cartridge (9) by 
aligning its left side indentation (10) 
with the protrusion (11) on the image 
drum so the toner cartridge and image 
drum color labels align. Then fix the 
right side firmly into place.
Note

●● Do not insert a toner cartridge without removing the 
tape.

1011

9
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10	 Turn the blue lever (6) of the toner 
cartridge backward until its top aligns on 
the  mark.

6

11	 Close the output tray (4) by pushing the 
both sides of the cover firmly.

4

12	 Close the front cover (2).

2

Note

●● The front cover cannot be closed if the output tray is 
not closed securely.

13	 Please recycle toner cartridges.
Memo

●● If you must dispose of a toner cartridge, put it in a 
plastic bag or similar container and dispose of it in 
accordance with your municipality’s ordinances or 
guidelines.

Replacing the Image Drum

Life Span of Image Drum

When the “%COLOR% Image Drum Near 
Life” message appears on the display screen, 
prepare a replacement image drum. 
If you continue printing, the message 
“%COLOR% Image Drum Life” will be 
displayed and printing will stop.

A guideline for replacing the image drum is 
every 30,000 pages or so for A4 sized paper 
(with single-sided printing). However, this 
number of pages is for common printing 
conditions (3 pages at a time). Printing one page 
at a time reduces the drum life by about half.

The actual number of printed pages may be 
halved again relative to the above guideline, 
depending on the printing conditions.

If you continue to print more than the above, 
the printer will force the printing to stop.

Note

●● The actual number of pages you can print with the image 
drum depends on how you use it. The above guideline 
may be reduced by more than half, depending on the 
conditions of printing.

●● Though opening and closing the output tray may extend 
the life of a image drum for a while, it is recommended to 
replace it soon after the “Install New image drum” is 
displayed.

●● The print quality may deteriorate after the toner cartridge 
has been unpacked for a year. Replace it with a new one.

●● Press the scroll button  or  and select [Admin Setup] >  
[Panel Setup] > [Near Life Status], if this is set to  
[Disable], then the “%COLOR% Image Drum Near 
Life” message does not appear.

Procedure for Replacement

Note

●● If you use a new image drum with the toner cartridges 
currently in use, the remaining amount indication of the 
toner cartridges will not display correctly. 
The messages “%COLOR% Image Drum Near Life” or 
“%COLOR% Image Drum Life” may also be displayed 
soon after replacement.

●● The image drum (the green tube) is very delicate. Handle 
it carefully.

●● Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

●● In order for the printer to exhibit its full performance, 
please use genuine OKI consumables.

●● Service for problems due to use of consumable items 
other than genuine OKI consumables will incur fees 
even in the warranty period or the maintenance contract 
period. (Use of consumable items other than genuine OKI 
consumables does not always cause problems, but please 
exhibit caution when using those.)
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●● There is one toner cartridge for each color on the image 
drum.

1	 Prepare a new image drum.

2	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

3	 Press the output tray open button (3) 
and open the output tray (4).

CAUTION Possible to get 
burned.

●● The fuser unit is extremely hot. Do not touch 
it.

3
4

4	 Identify an empty toner cartridge by its 
label color (5).

5

5	 Remove the image drum (6) from the 
printer in the direction of the arrow and 
place the image drum on a flat surface.

6

6	 Turn the right blue lever (7) of the toner 
cartridge forward while pressing the top 
of the toner cartridge to unlock.

7

7	 Lift the toner cartridge (8) from the 
right side, and remove it from the image 
drum.

WARNING Possible to get 
burned.

●● Do not throw a used image drum and toner 
cartridge in the fire. They may explode, and 
the toner inside may fly off and cause getting 
burned.

8
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8	 Remove the protective sheets. 
Place a new image drum (9) on a flat 
surface.

9

9	 Remove the toner cover (10).

10

10	 Insert the toner cartridge (8) taken 
out in step 7 to the image drum (9) by 
aligning its left side indentation (11) 
with the protrusion (12) on the image 
drum, and then fix the right side firmly 
into place.

8

12

9

11

11	 Turn the blue lever (7) of the toner 
cartridge backward until its top aligns on 
the  mark.

7

12	 Check a label color of a new image drum 
(9) and place the drum into a printer.

9

13	 Close the output tray (4) by pushing the 
both sides of the cover firmly.

4
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14	 Close the front cover (2).
Note

●● The front cover cannot be closed if the output tray is 
not closed securely.

2

15	 Please recycle image drums.
Memo

●● If you must dispose of an image drum, put it in a 
plastic bag or similar container and dispose of it in 
accordance with your municipality’s ordinances or 
guidelines.

●● If the light-shielding film of the image drum becomes 
dirty, wipe the film by following the procedures 
below.

(1)	 Open the front cover.

(2)	 Open the output tray.

(3)	 Remove the image drum.

(4)	 Wipe the light-shielding film with soft 
tissue paper.

(5)	 Put the image drum back to the 
printer.

(6)	 Close the output tray by pushing the 
both sides of the cover firmly.

(7)	 Close the front cover.

Replacing the Belt Unit

Life Span of Belt Unit

When the “Belt Unit Near Life” message 
appears on the display screen, prepare a 
replacement belt unit. You can keep printing 
approximately 2000 pages until the next 
message appears.

When the “Change Belt Unit” message 
appears, replace the belt unit.

The life expectancy of the belt unit is 
approximately 80,000 pages for A4 simplex 
printing (three pages per job).

Note

●● The actual number of pages you can print with the belt 
unit depends on how you use it.

Note

●● Though opening and closing the output tray may extend 
the life of the belt unit somewhat, you should replace it 
soon after the “Change Belt Unit” is displayed to prevent 
malfunction.

●● If you replace the belt unit, use it until the end of its 
useable life. If you remove the belt unit and install and 
use another one before its usable life has expired, the use 
life will not be correctly displayed.

●● Press the scroll button  or  and select [Admin Setup] >  
[Panel Setup] > [Near Life Status], if this is set to 
[Disable], then the “Belt Unit Near Life” message does 
not appear.

Procedure for Replacement

Note

●● The image drum (the green tube) is very delicate. Handle 
it carefully.

●● Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

1	 Prepare a replacement belt unit.

2	 Turn off your printer by pressing the 
power switch.
Reference

●● “Turning Off the Power” P.21
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3	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

4	 Press the output tray open button (3) 
and open the output tray (4).

CAUTION Possible to get 
burned.

●● The fuser unit is extremely hot. Do not touch 
it.

3
4

5	 Take all the four image drums out of a 
printer, and then place them on a flat 
surface.

6	 Cover the image drums you took out 
with paper so that the image drums do 
not expose to the light.

7	 Turn the blue locks (5) on each side of 
the belt unit in direction of the arrow to 
unlock.

5

5

8	 Remove the belt unit by holding the blue 
lever (6).

6
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9	 Hold the handle of a new belt unit with 
one hand and support lower part with 
other hand. Place the belt unit into the 
printer.

10	 Turn the blue locks (5) on each side of 
the belt unit in direction of the arrow.

5

5

11	 Return all the four image drums to the 
printer.

12	 Close the output tray (4) by pushing the 
both sides of the cover firmly.

4

13	 Close the front cover (2).
Note

●● The front cover cannot be closed if the output tray is 
not closed securely.

2

14	 Please recycle belt unit.
Memo

●● If you must dispose of a belt unit, put it in a 
plastic bag or similar container and dispose of it in 
accordance with your municipality’s ordinances or 
guidelines.
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Replacing the Fuser Unit

Life Span of Fuser Unit

When the “Fuser Unit Near Life” message 
appears on the display screen, prepare a 
replacement fuser unit. You can keep printing 
approximately 2500 pages until the next 
message appears.

When the “Change Fuser Unit” message 
appears, replace the fuser unit.

The life expectancy of the fuser unit is up to 
100,000 pages for A4 simplex printing.

Note

●● The actual number of pages you can print with the fuser 
unit depends on how you use it.

Note

●● Though opening and closing the output tray may extend 
the life of the fuser unit somewhat, you should replace it 
soon after “Change Fuser Unit” is displayed to prevent 
malfunction.

●● If you replace the fuser unit, use it until the end of its 
useable life. If you remove the fuser unit and install and 
use another one before its usable life has expired, the use 
life will not be correctly displayed.

●● Press the scroll button  or  and select [Admin Setup] >  
[Panel Setup] > [Near Life Status], if this is set to 
[Disable], then the “Fuser Unit Near Life” message does 
not appear.

Replacement Procedure

Note

●● Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

1	 Prepare a new fuser unit.

2	 Turn off your printer by pressing the 
power switch.
Reference

●● “Turning Off the Power” P.21

3	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

4	 Press the output tray open button (3) 
and open the output tray (4).

CAUTION Possible to get 
burned.

●● Since the fuser unit gets hot, carry out the 
operation carefully, and when lifting it up 
you must hold it by the handle. Do not try to 
hold it whilst it is hot. Wait until it has cooled 
down and then carry out the operation.

3
4

5	 Pull forward the left locking lever (5) of 
the fuser unit to unlock.

5
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6	 Hold the fuser unit handle (6) and lift 
the fuser unit out of the printer.

6

7	 Hold the fuser unit handle (6) and place 
the fuser unit into the printer.

6

8	 Push back the left locking lever (5) of 
the fuser unit to lock.

5

9	 Close the output tray (4) by pushing the 
both sides of the cover firmly.

4

10	 Close the front cover (2).
Note

●● The front cover cannot be closed if the output tray is 
not closed securely.

2

11	 Please recycle fuser unit.
Memo

●● If you must dispose of a fuser unit, put it in a 
plastic bag or similar container and dispose of it in 
accordance with your municipality’s ordinances or 
guidelines.
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●● Cleaning
This section explains how to clean each part of your printer.

Cleaning the Surface of the 
Printer

Note

●● Do not use benzine, thinners, or alcohol as a cleaning 
agent. They may damage the plastic parts of the printer.

●● Do not lubricate your printer with oil.

1	 Turn off your printer by pressing the 
power switch.
Reference

●● “Turning Off the Power” P.21

2	 Wipe the surface of the printer with a 
soft cloth lightly moistened with water or 
neutral detergent.

3	 Dry the surface of the printer with a dry 
soft cloth.

Cleaning Paper Feed Rollers

Clean the paper feed rollers if paper jams occur 
frequently.

Note

●● You should replace the paper feed rollers if paper jams 
keep occurring even after cleaning the paper feed rollers.

For Tray 1/2/3/4

Memo

●● This procedure images use tray 1 as an example, but the 
same procedure applies to tray 2/3/4.

1	 Pull out the tray (1).

1

2	 Wipe the two paper feed rollers (2) 
inside the printer with a wet cloth that 
has been wrung out well.

2

3	 Remove paper loaded in the tray.

4	 Wipe the paper feed roller (3) on the 
tray with a wet cloth that has been 
wrung out well.

3

5	 Load paper in the tray.

6	 Push the tray back into the printer.

For MP Tray

1	 Open the MP tray (1) forward by 
inserting your fingers into the front 
recesses (2).

2

2

1



- 117 -

Cleaning

4

4
.	

M
ain

ten
an

ce

2	 Release the tab (3) of the paper feed 
roller cover by pressing the right arm (4) 
inward while lifting up the MP tray (1) 
lightly.

1

4

3

3	 Also press the left arm (4) inward while 
lifting up the MP tray (1) lightly to 
release the tab (3) of the paper feed 
roller cover.

1

4

3

4	 Open the paper set cover (5) until 
touching the printer.

5

5	 Wipe the two paper feed rollers (6) with 
a wet cloth that has been wrung out 
well.

6

6	 Open the separation roller cover (7) 
forward while pressing the center part of 
the MP tray. 
Wipe the two separation roller (8) with a 
wet cloth that has been wrung out well.

7

8

7	 Close the separation roller cover (7).

7

8	 Lower the paper set cover (5).

5
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9	 Hook one tab (3) of the paper feed roller 
cover by pressing the right arm (4) 
inward while lifting up the MP tray (1) 
lightly.
Note

●● If closing the MP tray without returning the tab to the 
correct position, the paper set cover may be broken. 
Be sure to return the tab to the original position.

1

4

3

10	 Also hook the other tab (3) of the paper 
feed roller cover by pressing the left arm 
(4) inward while lifting up the MP tray 
(1) lightly.
Note

●● If closing the MP tray without returning the tab to the 
correct position, the paper set cover may be broken. 
Be sure to return the tab to the original position.

1

4

3

11	 Close the MP tray (1).
If the MP tray cannot be closed, return the paper 
set cover to the correct position by pressing the 
paper loading part on the MP tray downward.

1

Cleaning LED Heads

Clean the LED heads if vertical lines appear, 
images are fading vertically, or the periphery of 
letters is smudged in the printouts. Dirt on the 
LED heads may also cause paper jams.

Note

●● Do not use methyl alcohol or thinners as a cleaning agent. 
They may damage the LED heads.

●● Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

1	 Turn off your printer by pressing the 
power switch.
Reference

●● “Turning Off the Power” P.21

2	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

3	 Press the output tray open button (3) 
and open the output tray (4).

CAUTION Possible to get 
burned.

●● The fuser unit is extremely hot. Do not touch 
it.

3
4
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4	 Lightly wipe the lenses (5) of the LED 
heads with soft tissue paper.

5

5	 Close the output tray (4) by pushing the 
both sides of the cover firmly.

4

6	 Close the front cover (2).
Note

●● The front cover cannot be closed if the output tray is 
not closed securely.

2
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●● Moving or Transporting Your Printer
This section explains how to move or transport your printer.

Moving Your Printer

CAUTION It may cause injury!

●● At least two people are needed to lift the printer 
safely because it weighs about 37 Kg or 40 Kg.

1	 Turn off your printer by pressing the 
power switch.
Reference

●● “Turning Off the Power” P.21

2	 Unplug all the cables.

●● AC cord and ground wire

●● Ethernet or USB cable

3	 Remove any paper from the paper trays.

4	 Lift your printer and move it to a new 
location.

Transporting Your Printer

CAUTION It may cause injury!

●● At least two people are needed to lift the printer 
safely because it weighs about 37 Kg or 40 Kg.

CAUTION Possible to get 
burned.

●● The fuser unit is extremely hot. Do not touch it.

Note

●● The image drum (the green tube) is very delicate. Handle 
it carefully.

●● Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

1	 Turn off your printer by pressing the 
power switch.

 

Reference

●● “Turning Off the Power” P.21

2	 Unplug all the cables.

●● AC cord and ground wire.

●● Ethernet or USB cable.

3	 Remove any paper from the paper trays.

4	 Insert your finger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

5	 Press the output tray open button (3) 
and open the output tray (4).

CAUTION Possible to get 
burned.

●● The fuser unit is extremely hot. Do not touch it.

3
4
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6	 Hold the toner cartridges with both 
hands and remove them with the image 
drums. Remove all the toner cartridges 
and image drums, and place them on a 
flat surface.

7	 Secure each toner cartridge to each 
image drum with vinyl tape (5).

5

8	 Return all the toner cartridges and 
image drums to the printer.

9	 Close the output tray (4) by pushing the 
both sides of the cover firmly.

4

10	 Close the front cover (2).
Note

●● The front cover cannot be closed if the output tray is 
not closed securely.

2

11	 Remove the optional additional tray unit 
from the main unit if it is installed.
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12	 Protect your printer with packing 
materials.

13	 Lift your printer and put it in a box.
Note

●● Use the packing materials attached to your printer 
when purchased.

●● After transporting or when setting up again, remove 
the vinyl tape used to secure the image drum and 
toner cartridges.
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●● Before Machine Disposal
Before this machine is disposed of, it is recommended to erase the registered privacy data and the 
stored data.

The data stored in the machine is shown below.

●● Admin password

●● Registered settings in various menus

●● Private printing data

●● Various records

●● Access control, user management data (local user, external user cache [LDAP, Kerberos])

1	 Press the scroll button  or  on the 
operator panel.

2	 Press the scroll button  several times 
to select [Admin Setup], and press the 
<ENTER> button.

3	 Input the admin password.

4	 Select [Others Setup] > [Erase 
Privacy Data].

5	 Once [Are You Sure?] is displayed, 
select [Yes], and press the <ENTER> 
button.

6	 Once [Would you like really?] is 
displayed, select [Yes], and press the 
<ENTER> button.

Restart the machine to erase the data.

Note

●● Once the action is executed, the erased data cannot 
be restored. To cancel the erasing, select [No] in 
step 5 or step 6.
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5.	Appendix
This chapter explains the specifications of your printer.

●● Menu List of the Operator Panel

Checking the Printer’s Status with the Display Screen

From the  or  button on the operator panel, you can check the status of your printer.

Checking the Device Status

You can check the residual life of the consumables, counter information, network settings and system 
information on the display screen.

1	 Press the  button on the operator panel 
to open the status menu.

2	 Press the scroll button  to select the 
item you want to check and then press 
the <ENTER> button.
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Menu List of the Operator Panel

The function number is described on the right of each item.
Functions

Print From USB Memory Select Print File
Print Setup Paper Feed

Copies
Duplex
Binding
Fit
Color Mode

Print Shared Print F1
Private Print F2 : You must input a password.

Configuration Tray Count MPTray
Tray1
Tray2  
(When tray2 is installed)
Tray3  
(When tray3 is installed)
Tray4  
(When tray4 is installed)

A4/Letter Impressions 
Count

Color
Mono

Supplies Life Cyan Toner (n.nK)
Magenta Toner (n.nK)
Yellow Toner (n.nK)
Black Toner (n.nK)
Cyan Drum
Magenta Drum
Yellow Drum
Black Drum
Belt
Fuser

Network Network Information Printer Name
Short Printer Name
Enabling Default Gateway  
(When Wireless LAN is installed)
Wired
IPv4 Address
Subnet Mask
Gateway Address
MAC Address
NIC Program Version
Web Remote Version
IPv6 Address (Local)
IPv6 Address (Stateless Address)
IPv6 Address (Stateful Address)

Wireless(Infrastructure) Infor-
mation  
(When Wireless LAN is installed)

Firmware Version
Wireless(Infrastructure)
SSID
Security
State
Band
Channel
RSSI
IPV4 Address
Subnet Mask
Gateway Address
MAC Address
IPv6 Address (Local)
IPv6 Address (Stateless Address)
IPv6 Address (Stateful Address)

Wireless(AP Mode) Information 
(When Wireless LAN is installed)

Wireless(AP Mode)
SSID
Password  
(When AP Mode User Setting is disclosed)
Number of connected

To NEXT PAGE IPv4 Address
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System Serial Number
Asset Number
Lot Number
Firmware Version
CU Version
PU Version
Panel Version
RAM
Flash Memory
SD Card
Date and Time

Print Information Configuration F100
Network F101
Demo Page DEMO1

...
File List
PS Font List
PCL Font List
IBM PPR Font List
EPSON FX Font List
HP-GL2 Palette
Usage Report F102 Copies
Supplies Report
Error Log F103
Color Profile List Memo

(    ) indicates the factory default setting.
Job Log

Menus Tray Configuration MPTray Config Paper Size (A4 ) F90
X Dimension (210millimeter) F91
Y Dimension (297millimeter) F92
Media Type (Plain) F93
Media Weight (Light) F94
Tray Usage (When Missmatching) F95

Tray1 Config Paper Size (Cassete Size) F10
X Dimension (210millimeter) F11
Y Dimension (297millimeter) F12
Media Type (Plain) F13
Media Weight (Light) F14
Legal Paper (Legal14)

Othre Size (16K (184x260mm) )

Tray2 Config  
(When tray2 is installed)

Paper Size (Cassete Size) F20
X Dimension (210millimeter) F21
Y Dimension (297millimeter) F22
Media Type (Plain) F23
Media Weight (Light) F24
Legal Paper (Legal14)

Othre Size (16K (184x260mm) )

Tray3 Config  
(When tray3 is installed)

Paper Size (Cassete Size) F30
X Dimension (210millimeter) F31
Y Dimension (297millimeter) F32
Media Type (Plain) F33
Media Weight (Light) F34
Legal Paper (Legal14)

Othre Size (16K (184x260mm) )

Tray4 Config  
(When tray4 is installed)

Paper Size (Cassete Size) F40
X Dimension (210millimeter) F41
Y Dimension (297millimeter) F42
Media Type (Plain) F43
Media Weight (Light) F44
Legal Paper (Legal14)

Othre Size (16K (184x260mm) )

Paper Feed (Tray1) F80
Auto Tray Switch (On)
Tray Sequence (Down)
Duplex Last Page  
(Skip Blank Page)To NEXT PAGE
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System Adjust Power Save Time (1 minute) F200
SleepTime (15 minutes) F201
Auto Power Off Time (4 hours) F202
Silent Mode (On)
Clearable Warning (ONLINE)
Auto Continue (Off)
Manual Timeout (60 seconds)
Timeout InJob (40 seconds)
Timeout Local (40 seconds)
Timeout Network (90 seconds)
Low Toner (Continue)
Print Mode w/o Color Toner 
(Alarm)
Jam Recovery (On)
Error Report (Off) F210
Hex Dump F237

Print Adjust Print Position Adjust MPTray F220 X Adjust (0.00millimeter)
Y Adjust (0.00millimeter)
Duplex X Adjust (0.00millimeter)
Duplex Y Adjust (0.00millimeter)

Tray1 F221 X Adjust (0.00millimeter)
Y Adjust (0.00millimeter)
Duplex X Adjust (0.00millimeter)
Duplex Y Adjust (0.00millimeter)

Tray2  
(When tray2 is 
installed)

F222 X Adjust (0.00millimeter)
Y Adjust (0.00millimeter)
Duplex X Adjust (0.00millimeter)
Duplex Y Adjust (0.00millimeter)

Tray3  
(When tray3 is 
installed)

F223 X Adjust (0.00millimeter)
Y Adjust (0.00millimeter)
Duplex X Adjust (0.00millimeter)
Duplex Y Adjust (0.00millimeter)

Tray4  
(When tray4 is 
installed)

F224 X Adjust (0.00millimeter)
Y Adjust (0.00millimeter)
Duplex X Adjust (0.00millimeter)
Duplex Y Adjust (0.00millimeter)

Paper Black Setting (0) F230
Paper Color Setting (0) F231
Trans. Black Setting (0) F232
Trans. Color Setting (0) F233
SMR Setting F234 Cyan (0)

Magenta (0)
Yellow (0)
Black (0)

BG Setting F235 Cyan (0)
Magenta (0)
Yellow (0)
Black (0)

HU Setting (Off)
VL Cleaning
Gloss Mode (Off)
Drum Cleaning (Off) F236
High Humid Mode (Off)
Moisture Control (Off)
Narrow Paper Speed (Mode1)
Warmup Control (Off)

To NEXT PAGE Quiet Mode (Off)
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Admin Setup Network Setup Enabling Default Gateway  
(When Wireless LAN is installed)

: You must input 
a password.

Wired (Enable)
TCP/IP (Enable)
NetBIOS over TCP (Enable)
IP Address Set (Auto)
IPv4 Address
(When the IP address is set manually)
Subnet Mask
(When the IP address is set manually)
Gateway Address
(When the IP address is set manually)
DHCPv6 (Disable)
Web (Enable)
Telnet (Disable)
FTP (Disable)
IPSec (if enabled) (Disable)
SNMP (Enable)
Network Scale (Normal)
Gigabit Network (Disable)
Hub Link Setting (Auto Negotiate)
Network Factory Defaults

USB Setup USB (Enable)
Speed (480Mbps)
Soft Reset (Disable) 
Serial Number (Enable)
Offline Receive (Disable)
USB Memory Interface (Enable)
Connected Host (Normal)

Print Setup Personality (Auto)
Copies (1)
Duplex (Off)
Binding (Long Edge)
Media Check (Enable)
A4/Letter Override (Yes)
Resolution (600dp)
Toner Save Toner Save Level (Off)

Color (All)
Mono-Print Mode (Auto)
Default Orientation (Portrait)
Edit Size (Cassette Size)
X Dimension (210millimeter)
Y Dimension (297millimeter)

PS Setup L1 Tray (Type1)
Network Protocol (RAW)
USB Protocol (RAW)
PDF Paper Size (Current Tray Size)
PDF Scaling Size (99%)

PCL Setup Font Source (Resident)
Font Number (I0)
Font Pitch (10.00CPI)
Font Height (12.00 point)
Symbol Set (PC-8)
A4 Print Width (78 column)
White Page Skip (Off)
CR Function (CR)
LF Function (LF)
Print Margin (Normal)
True Black (Off)
Pen Width Adjust (On)
Tray ID# MPTray (4)

Tray1 (1)
Tray2 (5)  
(When tray2 is installed)
Tray3 (20) 
(When tray3 is installed)
Tray4 (21)  
(When tray4 is installed)

XPS Setup DigitalSignature (Off)
DiscardControl (Auto)
MC Mode (On)
Unzip Mode (Speed)

To NEXT PAGE White Page Skip (Off)
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SIDM Setup SIDM Manual ID# (2)
SIDM Manual2 ID# (3)
SIDM MP Tray ID# (4)
SIDM Tray1 ID# (1)
SIDM Tray2 ID# (5)  
(When tray2 is installed)
SIDM Tray3 ID# (6)  
(When tray3 is instaled)
SIDM Tray4 ID# (7) 
(When tray4 is installed)

IBM PPR Setup Character Pitch (10 CPI)
Font Condense (12CPI to 20CPI)
Character Set (SET-2)
Symbol Set (IBM-437)
Letter O Style (Disable)
Zero Character (Normal)
Line Pitch (6 LPI)
White Page Skip (Off)
CR Function (CR)
LF Function (LF)
Line Length (80 column)
Form Length (11.7 inch)
TOF Position (0.0 inch)
Left Margin (0.0 inch)
Fit To Letter (Disable)
Text Height (Same)
Continuous Paper Mode (Off)

EPSON FX Setup Character Pitch (10 CPI)
Character Set (SET-2)
Symbol Set (IBM-437)
Letter O Style (Disable)
Zero Character (Normal)
Line Pitch (6 LPI)
White Page Skip (Off)
CR Function (CR)
Line Length (80 column)
Form Length (11.7 inch)
TOF Position (0.0 inch)
Left Margin (0.0 inch)
Fit To Letter (Disable)
Text Height (Same)
Continuous Paper Mode (Off)

Private Print Setup  
(When SD Memory card is installed)

Verify job option (Disable)
Erase job option (No overwrite)
Keep job for (2 hours)
Job Limitation (Disable)
Verify job password (Off)
Job Auto Search (On)

Color Setup Ink Simulation (Off)
UCR (Low)
CMY 100% Density (Disable)
CMYK Conversion (On)

Panel Setup Near Life Status (Enable)
Near Life LED (Enable)
Idle Display (Toner Gauge)
Panel Contrast (0)

Buzzer Setup Paper Jam Error Buzzer Volume (Off)

Time Setup Date Format (dd/mm/yyyy)
Time Zone (+0:00)
Daylight Saving (Off)
Setting method (Manual Setup)
SNTP Server (Primary)
SNTP Server (Secondary)
Time Setting (01/01/2000 00 :00)

Power Setup Auto Power Off (Auto Config)

Tray Setup Unit Of Measure (millimeter)
To NEXT PAGE Default Paper Size (A4)
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Others Setup RAM Setup Receive Buffer Size (Auto)
Resource Save (Off)

Flash Memory Setup Initialize

SD Card Setup  
(When SD Memory card is installed)

Initialize
Format Partition (PCL)
Erase SD Card

Storage Common Setup Check File System
Check All Sectors
Enable Initialization (No)

Job Log Setup Clear Job Log

Security Setup Access Control (Disable)
User Counter Report

Language Setup Select Language (English)
Language Initialize

Job Cancel Setup Cancel Key Behavior (Short)
Inquiry Display (On)
Focus Position (Yes)
Display Timeout (180)

Near Life Setup Drum Near Life Timing (3000)
Fuser Near Life Timing (2500)
Belt Near Life Timing (2000)

Erase Privacy Data

Business Phone Setup Business Phone Cooperation (Disable)
Connection IP Address (0.0.0.0)
Connection Port No. (59000)

Settings Reset Settings
Save Settings
Restore Settings

Change Password New Password Verify Password

Calibration Auto Density Mode (On)
Adjust Density F300
Adjust Registration F301
Color Density Cyan Density (0) F310

Magenta Density (0) F311
Yellow Density (0) F312
Black Density (0) F313

Print Color Tuning Pattern F302

Cyan Tuning Highlight (0)
Mid-Tone (0)
Dark (0)

Magenta Tuning Highlight (0)
Mid-Tone (0)
Dark (0)

Yellow Tuning Highlight (0)
Mid-Tone (0)
Dark (0)

Black Tuning Highlight (0)
Mid-Tone (0)
Dark (0)

Google Cloud 
Print

Print Manually
Delete Registered Info 
Register To Google Cloud Print
Google Cloud Print Settings Using Cloud Service (Enable)

DNS Server (Primary) (0.0.0.0)
: You must input a password. DNS Server (Secondary) (0.0.0.0)

Proxy (Disable)
Proxy Server
Proxy Server Port No. (8080)
Proxy User ID

To NEXT PAGE Proxy Password
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Wireless(Infrastructure) Setting 
(When Wireless LAN is installed)

Wireless(Infrustructore) (Disable)

Network Setting IP Address Set (Auto)
: You must input a password. IPv4 Address 

(When the IP address is 
set manually)
Subnet Mask 
(When the IP address is 
set manually)
Gateway Address 
(When the IP address is 
set manually)
DHCPv6 (Disable)

Automatic setup (WPS) WPS-PBC
WPS-PIN

Wireless Network Selection xxxxxx
......

Manual Setup SSID
Security (Disable)
WEP Key
(When the security is set 
to WEP)
WPA Encryption Type
(When the security is set 
to WPA/WPA2-PSK or 
WPA2-PSK)
WPA Pre-Shared Key
(When the security is set 
to WPA/WPA2-PSK or 
WPA2-PSK)
Execute

Wireless reconnection

Wireless(AP Mode) Setting 
(When Wireless LAN is installed)

Wireless(AP Mode) (Disable)
Automatic Setup (PushButton)
Manual Setup
Connection Setting SSID

Password
IPv4 Address
Execute

AP Mode User Setting (Don’t disclose user)

Boot Menu Network Factory Defaults
Wireless Module (Disable)

: You must input a password. SD Card Setup  
(When SD Memory card is installed)

Enable SD Card (Yes)

To display the [Boot Menu], 
turn on the power while pressing 
the <ENTER> button. 

Storage Common Setup Check File System
Check All Sectors

Menu Lockout (Off)
Panel Lockout (Off)

Print Statistics Usage Report (Enable)
Maintenance Counter (Disable)

: You must input a password. Reset Main Counter
Reset Supplies Counter
Change Password New Password Verify Password
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●● Specifications

Model Model Number
C813/C823/C833/ES8433 N35100A, N35100B
C843/ES8443 N35101A, N35101B

�� General Specifications
C813/C823 C833/ES8433 C843/ES8443

CPU PowerPC464FP, 800 MHz
Memory 
(Maximum 
768 MB)

Resident 256 MB 512 MB
Option 256 MB/512 MB 512 MB

Flash ROM System Memory : 128MB
Storage Device SD memory card kit

●● Optional
16 GB

Weight 37 Kg (including consumables without a duplex unit), 
40 Kg (including consumables with a duplex unit)

Dimensions 449(W) x 552(D) x 360(H) mm
Power supply N35100A, N35101A :

110 - 127 VAC (Range 99 - 140 VAC), 50/60 Hz ± 2%
N35100B, N35101B :
220 - 240 VAC (Range 198 - 264 VAC), 50/60 Hz ± 2%

Power 
consumption

Typical 
operation

700 W

Idle 100 W
Peak 1400 W
Deep sleep 
mode

Voltage 110 - 127 VAC : Less than 0.7 W
Voltage 220 - 240 VAC : Less than 1.0W

Power save 
mode

Less than 12 W

Off mode Voltage 110 - 127 VAC : Less than 0.1 W
Voltage 220 - 240 VAC : Less than 0.15 W

Interface USB 2.0 (Hi-Speed), Ethernet 10BASE-T/100BASE-TX/1000BASE-TX, IEEE802.11 
a/b/g/n (Optional)

Display Graphics panel 60(W) x 32.6(H) mm, 128 x 64 dots
Supported OS ●● Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Vista, Windows 

Server 2012 R2, Windows Server 2012, Windows Server 2008 R2, Windows 
Server 2008

●● Mac OS X 10.8.5-10.11
Please refer to product requirements for details.
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�� Printing Specifications
C813/C823 C833/ES8433 C843/ES8443

Printing method Dry electrophotographic recording method with LED (Light-emitting diode)
Emulation language PCL6 (XL3.0 and PCL5c), 

EPSON FX, IBM ProPrinter, 
XPS

PCL6 (XL3.0 and PCL5c), PostScript 3, IBM ProPrinter, 
EPSON FX, XPS

Resident fonts PCL: 91 european fonts PCL: 91 european fonts
PS: 80 european fonts

Resolution 600 x 600 dpi, 600 x 1200 dpi, 600 x 600 dpi 2bit 1200 x 1200 dpi, 600 x 
600 dpi

Color Yellow, Magenta, Cyan, Black
Print speed (A4) Simplex: 23 ppm

Duplex: 19 ppm
Simplex: 35 ppm
Duplex: 27 ppm

Paper size Tray 1 Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B5, B4, A6, B6, 
Statement, 8.5SQ, Folio, custom size, 8K (260 x 368 mm, 270 x 390 mm, 273 x 
394 mm), 16K (197 x 273 mm, 195 x 270 mm, 184 x 260 mm)

Tray 2/3/4  
(Option)*

Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B4, B5, 8.5SQ, Folio, 
custom size, 8K (260 x 368 mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 
mm, 195 x 270 mm, 184 x 260 mm)

MP Tray Legal 13/13.5/14, letter, executive, tabloid, statement, A3, A4, A5, B4, B5, 
A6, B6, B6 Half, 8.5SQ, Folio, 4x6inch, 5x7inch, Nagagata #3, Nagagata #4, 
Nagagata #40, Youkei #0, Youkei #4, Kakugata #2, Kakugata #3, Hagaki, Oufuku 
Hagaki, C4, C5, DL, Com-10, index card (3 x 5 inch), custom size, 8K (260 x 368 
mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x 270 mm, 184 x 
260 mm)

Duplex 
Printing

Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B4, B5, B6, 8.5SQ, Folio, 
8K (260 x 368 mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x 
270 mm, 184 x 260 mm), custom size (148 - 297 mm (W) x 182 - 431 mm (L))

Custom size ●● Tray 1
105, 128 - 297 mm (W),         148, 182 - 431 mm (L)
(4.1, 5.0 - 11.7 inches (W),     5.8, 7.2 - 17.0 inches (L))

●● Tray 2/3/4 (option)*
148 - 297 mm (W),              182 - 431 mm (L)
(5.8 - 11.7 inches (W)          7.2 - 17.0 inches (L))

●● MP tray
64, 128 - 297 mm (W),          90, 182 mm - 1312, 431 mm (L)
(2.5, 5.0 - 11.7 inches (W),   3.5, 7.2 inches - 52.0, 17.0 inches (L))

Media type Plain paper (64 g/m2 - 256 g/m2), letterhead, transparency, label, bond, recycle, 
card stock, rough, glossy

Feeding method Automatic feeding from the tray 1, MP tray and additional tray unit (optional), 
Manual feeding from MP tray

Paper loading capacity ●● Tray 1

300 sheets of Standard paper /80 g/m2, total thickness 30 mm or lower.
●● MP tray

100 sheets of Standard paper /80 g/m2 and total thickness 10 mm or lower, 10 

envelopes/ weight of 85 g/m2.
●● Additional tray unit (optional)

530 sheets of Standard paper /80 g/m2, total thickness 53 mm or lower.
Output method Face up/Face down
Paper output capacity ●● Face up

100 sheets (less than 80 g/m2), 10 sheets (ultra-heavy/envelopes) 
●● Face down

200 sheets (less than 80 g/m2) 
Print guaranteed area 6.35 mm or more from the paper edge (not applicable to special media such as 

envelopes)
Print precision Print beginning:± 2 mm, paper skew:± 1 mm/100 mm, 

image expansion:± 1 mm/100 mm (80 g/m2)
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C813/C823 C833/ES8433 C843/ES8443
Warm-up time ●● From power on

32 seconds (at room temperature 25°C, rated voltage)
●● From power save mode

27 seconds (at room temperature 25°C, rated voltage)
Operating environment ●● When in operation

10 - 32°C / Relative Humidity of 20 - 80% (maximum wet bulb temperature of 
25°C, maximum dry bulb temperature of 2°C) 

●● When not in operation
0 - 43°C / Relative Humidity of 10 - 90% (maximum wet bulb temperature of 
26.8°C, maximum dry bulb temperature of 2°C) 

Conditions for the guarantee 
of print quality

●● Operating Range
Temperature 10°C, humidity 20 to 80% RH
Temperature 32°C, humidity 20 to 60% RH
Humidity 20% RH, temperature 10 to 32°C
Humidity 80% RH, temperature 10 to 27°C

●● Full-color Print Quality Assured Range
Temperature 17 to 27°C, humidity 50 to 70% RH

Consumables, Maintenance 
Unit

Toner cartridges, image drum, belt unit, fuser unit, feed roller set

*C813/C823 is available only Tray2.

�� Network Specifications
C813/C823 C833/ES8433 C843/ES8443

Interface Ethernet 10BASE-T/100BASE-TX/1000BASE-TX, IEEE802.11 a/b/g/n (Optional)
Protocol TCP/IPv4&v6, NetBIOS over TCP, DHCP, DHCPv6, BOOTP, HTTP, HTTPS, DNS, 

DDNS, WINS, UPNP, Bonjour, SMTP, SMTPS, POP3, POP3S, SNMPv1&v3, SNTP, 
IPP, IPPS, WSD Print, LLTD, IEEE802.1X, LPR, Port9100, Telnet, FTP, FTPS, IPSec, 
Secure Protocol Server, LDAP, LDAPS, Google Cloud Print



- 135 -

Specifications

5

5
.	

A
p
p
en

d
ix

Wireless LAN Specifications (Option)

Item
Wireless LAN standard IEEE802.11a/b/g/n conformity (2.4 GHz / 5 GHz)
Security Disable, WEP, WPA-PSK, WPA2-PSK, WPA-EAP, WPA2-EAP

Regulatory wireless LAN statements

- FCC Statement

- IC Statement

- Europe-CE Declaration of conformity.

FCC statement

FCC WARNING

Changes or modifications not expressly approved by the party responsible for compliance could void 
the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no guarantee that interference 
will not occur in a particular installation. If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

- Consult the dealer or an experienced radio/TV technician for help.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

IC statement

This device complies with Part 15 of FCC Rules and Industry Canada licence-exempt RSS standard(s). 
Operation is subject to the following two conditions: (1) this device may not cause interference, and 
(2) this device must accept any interference, including interference that may cause undesired operation 
of this device.

Le présent appareil est conforme aux la partie 15 des règles de la FCC et CNR d’Ubdustrie Canada 
applicables aux appareils radio exempts de licence. L’exploitation est autorisée aux deux conditions 
suivantes : (1) I’appareil ne doit pas produire de brouillage, et (2) I’utilisateur de I’appareil doit 
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d’en compromettre 
le fonctionnement.

This Class [B] digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe [B] est conforme à la norme NMB-003 du Canada.

Caution (FCC/IC):

5.15-5.25 GHz band is restricted to indoor operations only.

La bande 5150-5250 MHz est restreints à une utilisation à l’intérieur.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled 
environment and meets the FCC radio frequency (RF) Exposure Guidelines and RSS-102 of the IC radio 
frequency (RF) Exposure rules. This equipment should be installed and operated keeping the radiator at 
least 20 cm or more away from person’s body.
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This equipment complies with the essential requirements of the European Union directive 2014/53/EU.
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�� Printer Dimensions

449 mm

360 mm

760 mm
400 mm

498 mm

774 mm138 mm

138 mm

138 mm

1107 mm

255 mm 552 mm 300 mm

420 mm

TOP VIEW

SIDE VIEW

OPTION-INSTALLED VIEW (TRAY2/3/4)
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ATTENTION indicator............. 87

B

Belt Unit............................ 111

C

Custom Sizes....................... 58

D

Deep Sleep Mode.................. 67

Duplex Printing...............51, 58

E

Envelope............................. 49

F

Feed Rollers....................... 116

Fuser Unit......................... 114

I

Image Drum...................... 108

Install

Printer Driver 

(Mac OS X).........38, 44

Printer Driver 

(Windows)..........35, 43

IP Address........................... 35

M

Mac OS X............................ 31

MP Tray............................... 54

O

Other Error Messages............ 87

Output Tray......................... 62

P

Paper Jams.......................... 73

Paper Size................ 48, 51, 58

Paper Tray......................51, 58

Paper Weight..................48, 51

Placement Environment......... 16

Placement Space.................. 16

POWER SAVE button............. 22

Power Supply Conditions....... 20

Printer Driver.......35, 38, 43, 44

Product Requirements........... 31

R

Rear Output Tray.................. 62

T

Toner Cartridges................. 104

W

Windows............................. 31
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Contact Us
	 Italia www.oki.com/it

	 Français www.oki.com/fr

	 Deutschland www.oki.com/de

United Kingdom 		 www.oki.com/uk

	 Ireland www.oki.com/ie

	 España www.oki.com/es

	 Portuguesa www.oki.com/pt

	 Sverige www.oki.com/se

	 Danmark www.oki.com/dk

	 Norge www.oki.com/no

Suomi 		 www.oki.com/fi

	 Nederland www.oki.com/nl

	 België/Belgique 		 www.oki.com/be

	 Österreich www.oki.com/at

Schweiz/Suisse/Svizzera www.oki.com/ch

	 Polska www.oki.com/pl

Česká 		 www.oki.com/cz

Slovenská 	 www.oki.com/sk

Magyarország 	 www.oki.com/hu

Россия 	 www.oki.com/ru

Україна 	 www.oki.com/ua

	 Türkiye’ye www.oki.com/tr

	 Serbia www.oki.com/rs

	 Croatia www.oki.com/hr

	 Greece www.oki.com/gr

	 Romania www.oki.com/ro

	 OKI Europe www.oki.com/eu

	 Singapore www.oki.com/sg/

	 Malaysia www.oki.com/my/
ประเทศไทย www.oki.com/th/printing/

	 Australia www.oki.com/au/

New Zealand 			 www.oki.com/nz/

	 United States www.oki.com/us/

	 Canada www.oki.com/ca/

	 Brasil www.oki.com/br/printing

	 México www.oki.com/mx/

	 Argentina www.oki.com/la/

	 Colombia www.oki.com/la/

Other countries 		 www.oki.com/printing/
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